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Preface

Purpose

This guide describes:

Types of DIGITAL PATHWORK licenses.

Step-by-step instructions for using DIGITAL PATHWORKS license management software.

How to use the DIGITAL PATHWORKS License Manager.

How to troubleshoot licensing problems.

About this Guide

This guide is written for system administrators who need to:

Gain a basic understanding of DIGITAL PATHWORKS licensing concepts.

Ensure that valid clients receive DIGITAL PATHWORKS licenses.

Manage DIGITAL PATHWORKS licenses.

Solve and eliminate DIGITAL PATHWORKS license management problems.

This guide assumes you are familiar with basic license management software provided with the DIGITAL OpenVMS operating system. 

�Organization of this Guide

This guide contains the following sections: 

Section�Description��Chapter 1, How to Use PATHWORKS License Software� \Relate "using.doc!2", "How to Use PATHWORKS License Software" \D2HTargetDefault � �Provides an overview of the license server software and the license management tasks you perform.��Chapter 2, Setting Up PATHWORKS License Management� \Relate "setup.doc!6", "Setting Up PATHWORKS License Management" \D2HTargetDefault ��Describes how you configure and manage the license server software in your network environment.��Chapter 3, Configuring License Servers� \Relate "config.doc!4", "Configuring License Servers" \D2HTargetDefault ��Describes how to configure the license server software components on DIGITAL OpenVMS systems.��Chapter 4, Managing Licenses on the OpenVMS Platform� \Relate "ovms.doc!2", "Managing Licenses on the OpenVMS Platform" \D2HTargetDefault ��Describes how to use the License Manager in a DIGITAL OpenVMS system.��Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault ��Describes how to configure client software when it is used in conjunction with the License Server.��Appendix A, Client Messages� \Relate "cmess.doc!19", "Client Messages" \D2HTargetDefault ��Lists and describes the messages that are generated in response to client events.��Appendix B, Server Messages� \Relate "smess.doc!9", "Server Messages" \D2HTargetDefault ��Lists and describes the messages that are generated in response to server events.��Appendix C, PATHWORKS Licensing Software Licensing Process� \Relate "licsw.doc!10", "PATHWORKS Licensing Software Licensing Process"\D2HTargetDefault ��Describes the specific steps in the client licensing process and shows the algorithms used to determine what license to request.��

Related Documents

The following documents are part of the DIGITAL PATHWORKS for OpenVMS (Advanced Server) documentation set.  Reference these documents for complete descriptions and procedural information about the DIGITAL PATHWORKS for OpenVMS (Advanced Server) utilities and software interfaces.�

�Component Title� Description��DIGITAL PATHWORKS for OpenVMS�Server Installation and Configuration Guide�Explains how to install and configure all of the components of DIGITAL PATHWORKS for OpenVMS software including:

The Advanced Server

The NetWare Server

The license server

The Upgrade utility��DIGITAL PATHWORKS for OpenVMS (Advanced Server) Server Migration Guide�Explains how to upgrade the DIGITAL PATHWORKS for OpenVMS (LAN Manager) software to DIGITAL PATHWORKS V6 for OpenVMS (Advanced Server) software.��DIGITAL PATHWORKS for OpenVMS (Advanced Server) Server Administrator's Guide�Explains how to manage and customize the PATHWORKS for OpenVMS (Advanced Server) software.��PATHWORKS for OpenVMS (Advanced Server) Commands Reference Manual�Provides command syntax descriptions for all ADMINISTER commands available with DIGITAL PATHWORKS for OpenVMS (Advanced Server), and Net command equivalents. ��DIGITAL PATHWORKS for OpenVMS (Advanced Server) Concepts and Planning Guide�Provides an overview of and introduction to the DIGITAL PATHWORKS for OpenVMS (Advanced Server) software and associated networking concepts for system administrators and operators.��DIGITAL PATHWORKS for DOS and Windows Documents

Client Installation and Configuration Guide�Describes how to install  and configure the DIGITAL PATHWORKS Version 6 client software.��DIGITAL PATHWORKS for Windows NT Documents

Quick Start Card�Describes how to install  and configure licensing software for Windows NT.��DIGITAL PATHWORKS for OS/2 Documents

Installation and Configuration Guide�Describes how to install  and configure licensing software for OS/2.��

�Conventions

The following conventions are used in the Advanced Server documentation set:

Convention�Meaning��Ctrl/x�While you hold down the Ctrl key, press another key or a pointing device button.��Italic�Indicates a place holder for information or parameters that you must provide.  For example, if the procedure asks you to type file name, you must type the actual name of a file.

Italic also indicates new terms and the titles of other documentation referenced.��Monospace�Indicates the actual commands, words, or characters that you type in a dialog box or at a command prompt or system output.��Note:�Provides information of special importance.��Caution:�Provides information to avoid damaging the software or hardware.��Warning:�Provides information that is essential to people’s safety.��/�A forward slash in command descriptions indicates that a command qualifier follows.��. . .�A horizontal ellipsis following an entry in a command line indicates that the entry or a similar entry can be repeated any number of times.  An ellipsis following a file name indicates that additional parameters, values, or information can be entered.��.�.�.�A vertical ellipsis in an example indicates that not all the data is shown.��
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How to Use PATHWORKS License Software

Introduction

Any client accessing a DIGITAL PATHWORKS for OpenVMS server must be sufficiently licensed.  This section describes how the license software works, the licenses required to access the server, and how license management works.  The following topics are discussed: 

PATHWORKS Licensing System� \Relate "using.doc!13", "PATHWORKS Licensing System" \D2HTargetDefault � ( describes the different components of the licensing system and describes how licensing works. 

PATHWORKS (Advanced Server) License Management Models� \Relate "using.doc!21", "PATHWORKS (Advanced Server) License Management Models" \D2HTargetDefault � ( describes the different licenses available for accessing a PATHWORKS Advanced Server.

License Management Tasks� \Relate "using.doc!22", "License Management Tasks" \D2HTargetDefault � ( describes the tasks involved in managing PATHWORKS licenses and the features of the License Manager that allow you to perform these tasks.

PATHWORKS Licensing System

� XE "PATHWORKS Licensing System:description of" �The PATHWORKS license software on the server runs on DIGITAL OpenVMS and includes the following components: � XE "PATHWORKS Licensing System:components" �

License Server� XE "License server:description of" � ( A software program that assigns and verifies client-based licenses and performs license management tasks. 

License Manager� XE "License Manager:description of" �(A management interface between the system administrator and the PATHWORKS license server.  

License Registrar� XE "License Registrar:description of" �(A program that runs on the same node as the file server and validates that client access to the file service is licensed.  The License Registrar also manages server-based licenses.

The PATHWORKS licensing software that runs on the client includes the following components:

DIGITAL PATHWORKS Licensing Software Components ( There are two client-based license software components; the client license requester program and the client license transponder program.  Refer to Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault �, in this guide for more information about these programs.

Client License Requester � XE "Client license requester:description of" �(A program that runs on the client and requests licenses from the license server. 

Client License Transponder � XE "Client license transponder:description of"�(A program that runs on the client and communicates information about the client’s license to the License Registrar. 

The organization of these components is shown in the following figure. 

Figure �styleref "BeginChapter"�1�–�seq fignum�1�   PATHWORKS Licensing System � XE "PATHWORKS Licensing System:diagram" �

�



(  Client requests license assignment or verification.

(  Client requests to connect to the file server.

(  File server request to validate that a client is licensed for access to file server resources. 

(  License Registrar validates client’s license.

PATHWORKS Licensing System Components 

� XE "PATHWORKS Licensing System:components" �The following list summarizes how the components of the licensing system interact.

The PATHWORKS license server is installed and configured on an OpenVMS system.  This can be a standalone system or an OpenVMS cluster and does not necessarily have to be on the same system as the PATHWORKS server.  The PATHWORKS license server is an interface between the LMF database and the client software.  It services requests for client-based licenses.  

The License Registrar runs on the PATHWORKS file server system and determines if a client is licensed to use the PATHWORKS server resources.  The License Registrar validates client-based licenses and grants server-based licenses when they are needed and available.  

The License Registrar manages these PATHWORKS licenses called, server-based licenses.  For LAN Manager, this is the PWLMXXXCA licenses.  For NetWare, this is the PWNWVMSCU licenses. 

For server-based licensing, PATHWORKS licenses are loaded and registered on the file server system.  The License Registrar also maintains information about the licenses and periodically interfaces to LMF to determine changes to licenses, such as the addition of new licenses and the removal of licenses

When unlicensed clients access the PATHWORKS server resources, they are granted server-based licenses by the License Registrar, if they are available.  These Client Access licenses must be available to the license registrar for such server-based use ahead of time.

The License Manager: 

manages client-based licenses

specifies which Client Access licenses will be used as client-based licenses and which will be used as server-based licenses 

organizes client-based licenses into license groups 

generates reports of licensing activities

displays lists of clients that have been granted licenses

revokes licenses

Clients use the client license requester (CLR) and the client license transponder (CLT) programs to request and verify licenses.  The CLR program requests client-based licenses from the license server.  When the license server assigns a license to the client, the client provides license information to the CLT program.  Each time the client accesses PATHWORKS server resources, the CLT program presents this license information to the License Registrar so that the license can be validated. 

For a system to be a PATHWORKS license server, no special attributes are required.  However, make sure that the system is configured for and is running all of the transports used by clients requesting licenses.

A small amount of disk storage space on the server, less than 500 bytes per license managed, is also required.

Digital Equipment Corporation recommends that you use a single PATHWORKS license server to provide client-based licenses to all clients requiring a PATHWORKS client-based license in a local area network (LAN).  Both NetWare and LAN Manager clients can be issued licenses from the same license server.  There is no technical reason why you could not use a single PATHWORKS license server per wide area network (WAN) or multiple PATHWORKS license servers per LAN; these models are also supported.  However, using a single PATHWORKS license server per LAN, at least to start, provides a good degree of local control while keeping the administrative activity to a minimum.  Also, operating too many license servers within a single LAN can result in performance degradation. 

For increased availability, a license server can be run in an OpenVMS cluster .  Alternatively, two or more license servers can be run, although any given PAK can only be loaded on one OpenVMS system at a time.

� XE "OpenVMS clusters" �When registering and loading a new PATHWORKS license PAK on an OpenVMS cluster, use the LICENSE REGISTER command on one node of the cluster to register the PAK and then use the LICENSE LOAD command on each cluster member to load the licenses on that cluster member.  This ensures that PATHWORKS license components running on any member of the cluster will be able to detect the new licenses.  Failure to load the licenses on each cluster member may cause failures due to the PATHWORKS licenses components’ inability to detect licenses that are not loaded.

Configuring the License Services

� XE "Configuring:license services" �When you install the PATHWORKS file server, the License Registrar is automatically installed to ensure access to the server resources is validated.  The license server, however, is an optional component that is installed only if you answer YES to the appropriate prompt in the initial configuration dialog, PWRK$CONFIG, described in the PATHWORKS for OpenVMS Server Installation and Configuration Guide.

The PATHWORKS license server manages client-based licenses, including assignment of licenses to clients and allocation of licenses to license groups.

If you choose not to configure the license server to run, the License Registrar takes its licenses directly from LMF (the License Management Facility) and uses them exclusively as server-based licenses.  Simply load the licenses as described in the OpenVMS License Management Utility Manual.

If you choose to configure the license server, use the procedures described in this guide to allocate and manage licenses.  For more information on choosing client-based versus server-based licensing, refer to Chapter 2, Setting up PATHWORKS License Management� \Relate "setup.doc!6", "Setting up PATHWORKS License Management" \D2HTargetDefault �, in this guide.

Configuring Standalone License Servers 

� XE "Configuring:standalone license servers" �The PATHWORKS license server can run on a different system than the one that is running the PATHWORKS file server (such as PATHWORKS Advanced Server).  Digital Equipment Corporation recommends this configuration for the best performance of the file server system.  The system running the license server without a PATHWORKS file server is referred to as a standalone license server.

To configure a system to run the standalone license server, install the PATHWORKS for OpenVMS software as described in the Server Installation and Configuration Guide.  During the initial configuration dialog (PWRK$CONFIG), You should answer NO to the Advance Server and NetWare questions and answer YES to the prompt, "Do you want to run the standalone license server." When the procedure completes, start the license server as described.

When you install the PATHWORKS file server on another system in the local area network (LAN), configure the server so that the license server is not started on the same system with the file server.

For more information about license server configuration, refer to Chapter 3, Configuring License Servers� \Relate "config.doc!4", "Configuring License Servers" \D2HTargetDefault �, in this guide.

Configuring LANs and WANs 

� XE "Configuring:LANs and WANs" �� XE "LANs:configuring" �� XE "WANs:configuring" �The license server must be installed and running in the same LAN as the PATHWORKS file server that the clients need to access, if you are using client-based license management.  In a configuration with a standalone license server, client licenses are granted by the license server, and verified by the License Registrar running on the file server system.  Clients on computers outside of the LAN can obtain licenses for access to the PATHWORKS file server, if the license server is configured for wide-area network access.  Refer to Chapter 5, Configuring Client Software, the Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � section, in this guide for more information about how to provide WAN access to the license server.

Configuring Client Software 

� XE "Configuring:client software" �If the file server offers server-based licensing, and sufficient numbers of server-based licenses are available, the client computer needs no special software for requesting and storing the PATHWORKS license.

However, if the licenses are managed as client-based licenses, the client computer must have PATHWORKS licensing software to request and store PATHWORKS licenses.

The PATHWORKS client software for licensing is automatically installed and configured as part of the PATHWORKS client software installation procedure.  Therefore, if the client is running PATHWORKS 32, or PATHWORKS for Windows 95, no additional client software is needed.

However, if the client computer is not running PATHWORKS client software (for example, on a retail Windows NT workstation), the PATHWORKS client components for licensing (Client License Requester and Client License Transponder) must be loaded and set up on the client computer to request and store PATHWORKS client-based licenses.

These client components are available on the PATHWORKS file server system after you install the PATHWORKS software.  Refer to Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault �, in this guide for information about loading and customizing the client software for client-based licensing.

Upgrading from PATHWORKS V5 (LAN Manager) 

� XE "Upgrading from PATHWORKS V5" �To upgrade a file server that is currently running PATHWORKS V5 (LAN Manager) to PATHWORKS Advanced Server, refer to the PATHWORKS for OpenVMS (Advanced Server) Server Migration Guide.

If the system is running the standalone license server, however, you need not upgrade the server to PATHWORKS Advanced Server.  Upgrade the license server by simply installing and configuring it as described in the PATHWORKS for OpenVMS Server Installation and Configuration Guide.  No additional upgrade procedures are required for standalone license servers.

PATHWORKS (Advanced Server) License Management Models

� XE "PATHWORKS license management:models description of" �The PATHWORKS server requires that clients accessing file and print services be appropriately licensed.  To meet this requirement, one of the following must be true:

The client must have acquired a client-based license previous to connecting to a PATHWORKS server.

A server-based license must be available for each client connecting to a PATHWORKS file server without a client-based license.  

In either case, the license required to access PATHWORKS Advanced Server services is the Client Access license: PWLMXXXCA06.00.  This license can be configured to be used as either a client-based license or as a server-based license. 

Clients currently using client-based licenses to access PATHWORKS V5 LAN Manager servers need not be changed.  These clients will continue to access PATHWORKS LAN Manager servers using their client-based license.  However, to access the PATHWORKS Advanced Server they must obtain a new client-based license or a server-based license must be available for them on the file server system.  

Server-Based License Management 

� XE "Server-based license:management model" �Server-based licensing grants a specific number of clients connected to a PATHWORKS file server (on a first come, first served basis) the right to use PATHWORKS server software on a single server and allows clients access to file and print services resident on the server. 

When to Use a Server-Based License Management 

� XE "Server-based license:management, when to use" ��xe "Server-based license:about "�Server-based licensing is best suited for clients that need access to file and print services on a single server, or for a large number of clients that need occasional access to PATHWORKS file and print services.  Server-based licenses: 

Are consumed only for the duration of the connection.

Are consumed only by clients without appropriate client-based licenses.

Require no license software on the client.

Use one server-based license for each server session. 

How Server-Based License Management Operates 

� XE "Server-based license:management, operations" �� XE "Operations:for server-based license management" �On a file server that is not running the license server, Client Access licenses loaded into LMF are automatically used as server-based licenses.  From a license management point of view, this is the simplest form of management and does not require use of the license server licensing software on the client, or performing management tasks with the License Manager.  License management consists of loading the appropriate Client Access PAKs information into LMF on the file server node.  

When a client connects to the PATHWORKS file server, one server-based license is consumed and the client is granted access to the file server.  If there are no server-based licenses available when the client requests a connection to the file server, the connection request is denied.

After a server-based license has been used to grant a client access to a file server, the client is licensed to access resources on that server until the client disconnects from the file server.

When the client disconnects from the file server, the license assigned to that client is released, the number of available server-based licenses is incremented, and the license becomes available for another client. 

Server-Based License Management in an OpenVMS Cluster 

� XE "Server-based license:management, in an OpenVMS cluster" �When using server-based licenses for access to PATHWORKS file and print services in an OpenVMS cluster environment, Digital Equipment Corporation recommends that clients connect to the cluster using the PATHWORKS cluster alias, if this option is available.  Clients connecting using the alias consume one server-based license.  Clients connecting directly to specific cluster members consume one server-based license for each connection to a different cluster member.  

A client can map multiple drives and printers from a single server while consuming a single server-based license. 

Client-Based License Management 

� XE "Client-based license:management" �A client-based license is assigned on a per-workstation basis.  A client-based license for accessing PATHWORKS file servers allows a client to access multiple file servers with the single license.  Client-based licenses are managed using LMF, the PATHWORKS license server, and the PATHWORKS License Manager.  

After a client-based license has been assigned to a client, the license applies only to that client until it is revoked or released.  After a license has been revoked, it is available for assignment by the license server.  To revoke a client license, use the PATHWORKS License Manager.  

�xe "Client-based license:location of "�A client-based license PAK is loaded in the LMF database on the system running the license server.  The license server assigns a client-based license upon request for a license by a client.  After the client receives the license, it is stored on the client.  

How Client-Based License Management Operates 

� XE "Client-based license:management, operations" �� XE "Operations:for client-based license management" �PATHWORKS license management for client-based licenses consists of these types of client activities: 

Obtaining licenses from a PATHWORKS license server when first started after configuring PATHWORKS license management.

Verifying licenses with the PATHWORKS license server each time the client boots after the license has been assigned.

Presenting license information during the process of accessing PATHWORKS file servers.

These interactions require no specific actions on the part of a user once a client is configured to use PATHWORKS client-based license management.  

Combining Server-Based and Client-Based License Management 

� XE "Combined license:management" �You can use both server-based and client-based license management together on one PATHWORKS server, allowing you greater flexibility.

Appropriate client-based licensing assures access to PATHWORKS file servers.  Clients that do not have client-based licenses may access a file server if sufficient server-based license capacity exists.  

How Combined License Management Operates 

� XE "Combined license:management, operations" �In a combined-license environment, licenses are loaded in the LMF database on the system running the PATHWORKS  file server and the license server.  Client Access licenses loaded into LMF are automatically loaded by the license server.  When the licenses are first loaded by the license server, they are allocated to the Default license group to be used as client-based licenses.  The License Manager allows you to allocate any number of these licenses to the Server-Based license group so that they can be used for server-based licensing.  The remaining licenses, those in the Default group, or allocated to other license groups, are managed as client-based licenses. 

License Management Tasks 

� XE "License management:tasks" �The PATHWORKS licensing software includes the License Manager.  This software provides a user interface for system administrators to manage licenses. 

If the licensing environment consists of only server-based licensing, it is not necessary to use the License Manager.  When the licensing environment includes client-based licensing, or a combination of client-based and server based licensing, the License Manager is an invaluable tool for managing the licensing software. 

The tasks you perform with the License Manager include: 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Create and manage client software (system) licenses as well as client-based Client Access licenses.

Create and manage license groups that allow you to organize client-based licenses into subsets called license groups, or simply groups.  After you organize licenses into separate groups, licenses in a particular group are provided only to clients that identify themselves as members of the designated groups.  

For example, you could define three groups called Finance, Engineering, and Sales.  You could then place the number of licenses issued to a specific organization into the groups bearing the organization's name.  This ensures that their members can always acquire the licenses issued to them.  

Note:  To organize PATHWORKS client-based licenses into groups, you must take additional steps when configuring your client software.  Specifically, you must configure your clients to request a license from a particular license group.  Refer to Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault �, in this guide for more information.

Set alert levels that provide log entries in the �xe "Alert levels"� PATHWORKS license server log file when your supply of available PATHWORKS client-based licenses goes below the set level.  Use this feature on a per-product basis and/or per group basis.  

View the status of the PATHWORKS client-based licenses that have been assigned. 

Revoke client licenses.

Specify which license server events to log in the license server log file so that you can obtain a better understanding of client license related activity.

Add and remove product licenses from the license services database. 

Enable and disable the license server.

Generate reports of licenses assigned to clients.
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Setting Up PATHWORKS License Management

Introduction

PATHWORKS license management can be nearly transparent to both system administrators and users.  However, the PATHWORKS License Manager provides optional capabilities that allow you to configure your server in a way that best supports your computing environment.  This configuration may include client-based licensing, or a combination of client-based and server-based licensing. 

This section describes how to set up PATHWORKS for server-based licensing, for client-based licensing and for a combination of client-based and server-based licensing.  It also provides a set of examples of licensing setup.  This information is presented in the following sections:

Setting Up Server-Based License Management� \Relate "setup.doc!23", "Setting Up Server-Based License Management" \D2HTargetDefault � ( describes how to configure server-based licensing.

Setting Up Client-Based License Management� \Relate "setup.doc!24", "Setting Up Client-Based License Management" \D2HTargetDefault � ( describes how to configure client-based licensing. 

Setting Up Combined Client-Based and Server-Based License Management� \Relate "setup.doc!25", "Setting Up Combined Client-Based and Server-Based License Management" \D2HTargetDefault � ( describes how to configure the license management to support both server-based and client-based licensing.

Examples of PATHWORKS License Management� \Relate "setup.doc!26", "Examples of PATHWORKS License Management" \D2HTargetDefault � ( provides examples of license management configurations. 

Upgrading Client Licenses� \Relate "setup.doc!27", "Upgrading Client Licenses" \D2HTargetDefault � ( describes options for upgrading client licenses from PATHWORKS V5 to PATHWORKS V6.

Removing LAN Manager Licenses and Loading New Client Access Licenses� \Relate "setup.doc!28", "Removing LAN Manager Licenses and Loading New Client Access Licenses" \D2HTargetDefault � ( describes the results of a request or an attempt to verify a LAN Manager license if no licenses are loaded on the server.

Setting Up Server-Based License Management

� XE "Planning:server-based license management" �� XE "Server-based license:management, setting up" �� XE "Server-based license:management, planning" �� XE "Setting up:server-based license management" �The simplest form of license management is a configuration that supports only server-based licenses. Use the following steps to configure your PATHWORKS Advanced Server to support server-based licensing: 

Register and load the PAKs for your licenses using the License Management Facility (LMF) on the system where you will also be installing and running your PATHWORKS file server software.  For information on the LMF database, see the OpenVMS License Management Utility Manual.

Install, configure, and run your PATHWORKS file server software.

If no client-based licensing is required, you are finished.  You should not configure the PATHWORKS license server to run on this system.

Setting Up Client-Based License Management

� XE "Planning:client-based license management" �� XE "Client-based license:management, setting up" �� XE "Client-based license:management, planning" �For � XE "Setting up:client-based license management" �a configuration that supports client-based licensing, there are additional steps required for setting up the system.  This configuration requires the use of the license server and loading client software. 

Follow these steps to support client-based licenses:

Identify the system to be used as the PATHWORKS license server.

Register and load the related PAKs in the LMF database on the system chosen as the PATHWORKS license server.  For information on the LMF database, see the OpenVMS License Management Utility Manual.  

Install and configure your PATHWORKS license server software using the normal installation and configuration process for your server.  You can install the license server software either on the same system as a PATHWORKS file and print server, or on a different system, as a standalone license server.  The PATHWORKS license server normally puts only a very small additional load on a system.  For more information on how to load and configure PATHWORKS license servers, see the PATHWORKS for OpenVMS Server Installation and Configuration Guide.

Start your PATHWORKS license server.  For information about how to start the server, see the PATHWORKS for OpenVMS Server Installation and Configuration Guide.  

Using the License Manager, create any desired user-defined license groups and allocate licenses to these license groups.  By default, all Client Access licenses will be client-based licenses in the default group.

Install and configure the client software on clients that will be using PATHWORKS client-based licenses:

For clients using PATHWORKS client software (for example, PATHWORKS for DOS and Windows, or PATHWORKS 32), the client configuration procedure includes all the software and components necessary for clients to fully participate in the PATHWORKS license management process.

Note:  Depending on configuration or licensing needs, additional configuration setup might be required.

For non-PATHWORKS clients using client-based licensing, the PATHWORKS license management software must be loaded on the client before it can participate in the PATHWORKS license management process.  For details, see the README.TXT file provided with the PATHWORKS license management software for clients.

Restart the network on the client.  After the network restart is complete, clients can find a PATHWORKS license server and acquire the required license.

Setting Up Combined Client-Based and Server-Based License Management

� XE "Planning:combined license management" �� XE "Combined license:management, setting up" �� XE "Combined license:management, planning" �� XE "Setting up:combined license management" �For a configuration that supports both client-based and server-based licensing, you must  use the License Manager to specify which licenses are to be used as server-based and which are to be used as client-based.  

Follow these steps to configure your license server to support both client-based and server-based licensing:

Identify the PATHWORKS file server system to be used as the PATHWORKS license server.

Register and load the related PAKs in the LMF database on the system chosen as the PATHWORKS license server.  See the OpenVMS License Management Utility Manual for more information about how to load PAKs in the LMF database.  

Install and configure your PATHWORKS software using the normal installation and configuration process for your server.  For more information about how to install and configure PATHWORKS license servers, see the PATHWORKS for OpenVMS Server Installation and Configuration Guide.  

Start PATHWORKS.  See the PATHWORKS for OpenVMS Server Installation and Configuration Guide.  By default, all licenses will be client-based licenses.

Use the License Manager to configure the server-based licenses required.  Use the License Manager to allocate the desired number of server-based licenses from the Default group to the Server-Based group.  Licenses allocated to the server-based license group are reserved for use as server-based licenses and can not be assigned to clients by the license server.

Install and configure the client software on clients that will be using PATHWORKS client-based licenses:

For clients using PATHWORKS client software (for example, PATHWORKS for DOS and Windows, or PATHWORKS 32), the client configuration procedure includes all the software and components necessary for clients to fully participate in the PATHWORKS license management process.

Note:  Depending on configuration or licensing needs, additional configuration setup might be required.

For non-PATHWORKS clients, PATHWORKS license management software must be loaded on the client before it can participate in the PATHWORKS license management process.  For details, see the README.TXT file provided with the PATHWORKS license management software for clients.

For more information on how to configure server-based licenses, refer to Chapter 4, Managing Licenses on OpenVMS Systems, the Performing License Group Tasks� \Relate "ovms.doc!5", "Performing License Group Tasks" \D2HTargetDefault � section in this guide. 

Examples of PATHWORKS License Management

� XE "Examples:of license management" �� XE "PATHWORKS license management:examples of" �The following examples provide step-by-step instructions for using DIGITAL PATHWORKS licensing software and PAKs. �xe "PATHWORKS license management"� 

Example � styleref "BeginChapter" �2�–1   Setting Up Client-Based Licensing in a LAN� XE "Examples:setting up client-based licensing in a LAN" �

Configuration:�xe "PATHWORKS license management:examples of"� �xe ""� �xe "FPA license :used in a LAN "� 

The file server is running PATHWORKS V6.0 for OpenVMS (Advanced Server) in a LAN.  The license server is on the file server system. 

Clients have Microsoft Windows NT or Windows for Workgroups software already installed.

�Components:

PATHWORKS V6.0 for OpenVMS (Advanced Server) media and documentation kit.

A PAK for 750 PATHWORKS Version 6.0 Client Access (CA) licenses (PWLMXXXCA06.00).  

A PAK for PATHWORKS Client Licensing software (PWXXWINAT07.00).  

Procedure: 

Step�Action��1.

�Register and load PAKs into the License Management Facility (LMF) on the system that will run the PATHWORKS license server.  Follow the instructions provided in the OpenVMS Guide to Software License Management.��2.

�Install and configure PATHWORKS for OpenVMS (Advanced Server) software on one or more systems following the instructions found in the PATHWORKS for OpenVMS Server Installation and Configuration Guide.  Make sure you run the license server when configuring the PATHWORKS software on the node that will run the license server.  ��3.

�Load PATHWORKS client license software on the clients and configure them as described in Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault �, in this guide.  Clients are running Microsoft LAN Manager software and can access the PATHWORKS file and print servers.��4.�Start PATHWORKS on the node where the License Server is enabled.  Using the License Manager, optionally create license groups and allocate licenses to each client group as described in Chapter 4, Managing License on the OpenVMS Platform, the Performing License Group Tasks� \Relate "ovms.doc!5", "Performing License Group Tasks" \D2HTargetDefault � section in this guide.��5.�Restart the network software on the newly configured clients.��

�The following example demonstrates how to set up a license server to support client-based and server-based licensing in a WAN.

Example 2-2  Setting Up Combined Client-Based and Server-Based Licensing in a WAN� XE "Examples:setting up combined licensing in a WAN" �

Configuration�xe "PATHWORKS license management:examples of"�:

The file server is running PATHWORKS V6.0 (Advanced Server) and the license server is running on the file server system. 

Some clients are running  PATHWORKS 32 client software. 

Some clients are running Windows 95 and Windows NT client software.

Some clients are using client-based licensing.

Some clients are using server-based licensing. 

Components:

PATHWORKS Version 6.0 for OpenVMS media kit and documentation.

PATHWORKS 32 media kit and documentation.

A PAK for 125 PATHWORKS Client Access (CA) licenses (PWXXXCA06.00).  

Procedure: 

Step�Action���Choose a system to run the PATHWORKS license server.  On the license server system, register and load PAKs into the License Management Facility (LMF).  Follow the instructions provided by the OpenVMS License Management Utility Manual.��

�Install and configure PATHWORKS V6.0 for OpenVMS (Advanced Server) software on the file server system following the instructions found in the PATHWORKS for OpenVMS Server Installation and Configuration Guide.  Make sure you run the license server when configuring the PATHWORKS software on the node that will run the license server.��

�Appropriately install and configure the client software.  Refer to Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault �, in this guide for information and procedures.���Restart the network software on the newly configured clients.���Start the license server and the file server.���Use the License Manager to create license groups.  Allocate sufficient licenses to the Server-Based group to support server-based licensing. ��

Clients requesting assignment of a client-based license will obtain client-based licenses and others will use server-based licenses. 

The following example demonstrates how to configure the license server so that clients can use V5.0 licenses.

Example 2-3   Setting up a Server that Allows Clients to Request V5.0 Licenses� XE "Examples:setting up a server that allows clients to request V5.0 licenses" �

Configuration:  

The file server is already running PATHWORKS V5.0 for OpenVMS (LAN Manager).  The license server is not running on the file server system.

A license server is running standalone using PATHWORKS V5.0 for OpenVMS (LAN Manager) software, which will be upgraded to use PATHWORKS V6.0 for OpenVMS (Advanced Server) software.

Clients are using PATHWORKS V6.0 for DOS and Windows software.

Clients are using PATHWORKS V6.0 for DOS and Windows software use PATHWORKS V6.0 for DOS and Windows (LAN Manager) CCS licenses (PWLMDOSCC06.00).

Components:

PATHWORKS V5.0 for OpenVMS (LAN Manager) media and documentation kit (already installed on both the file server system and the standalone license server system).

PATHWORKS V6.0 for OpenVMS (Advanced Server) media and documentation kit.

PATHWORKS V6.0 for DOS and Windows media and documentation kit.

A PAK for 500 PATHWORKS V6.0 for DOS and Windows (LAN Manager) CCS licenses (PWLMDOSCC06.00) already registered and loaded on the standalone license server system.  

Procedure: 

Step�Action��1.�Upgrade the standalone license server software by installing and configuring the PATHWORKS V6.0 for OpenVMS (Advanced Server) software on the license server system.  During the installation procedure, specify that you do not want to install either the PATHWORKS V6.0 for OpenVMS (Advanced Server) or PATHWORKS V1.0F for OpenVMS (NetWare) software.  Then specify that you do want to install the PATHWORKS license server software.��2.

�Start the license server.  Licenses that wee previously served by the license server running the PATHWORKS V5.0 software will continue to be available and be served using the PATHWORKS V6.0 software.  In addition, if the client access licenses (PWLMXXXCA06.00) are purchased, they can be registered and loaded on the license server system and be served to clients requesting them.��

The following example demonstrates how to set up server-based licensing in a LAN or WAN.  

Example 2-4   Using Server-Based Licensing in a LAN or WAN� XE "Examples:using server-based licensing in a LAN or WAN" �

Configuration:�xe "PATHWORKS license management:examples of"� �xe "FPS license"�

The file server is running PATHWORKS V6.0 for OpenVMS (Advanced Server).

The license server is not running on the same system that the file server is running on. 

Clients have Microsoft Redirector software already installed.

All clients use PATHWORKS Version 6.0 for OpenVMS Client Access (CA) licenses (PWXXXCA06.00) as server-based licenses.  

Components:

PATHWORKS for OpenVMS media and documentation kit.

A PAK for 180 PATHWORKS Version 6.0 for OpenVMS Client Access (CA) licenses (PWXXXCA06.00).

Procedure:

Step�Action��1.

�Register and load your PAKs in the License Management Facility (LMF) on the system where the PATHWORKS file server will be used.��2.

�Install, configure, and run the PATHWORKS Advanced Server software.  Do not configure the PATHWORKS license server software for this system.��

Upgrading Client Licenses

� XE "Upgrading licenses:client licenses" �� XE "License management:upgrading" �If you are upgrading the server from PATHWORKS V5 (LAN Manager) to PATHWORKS Advanced Server, you should be aware that major differences introduced with the PATHWORKS Advanced Server include:

Any client accessing a PATHWORKS V6 (Advanced Server) must be sufficiently licensed for access; unlicensed clients or clients without a sufficient level of licensing will not be allowed access.

A higher-level license is required to access the PATHWORKS Advanced Server than is required to access the PATHWORKS LAN Manager Server.

In both of these cases, the license you want is the PATHWORKS Version 6.0 for OpenVMS Client Access (CA) license (PWXXXCA06.00).

Options for Upgrading Client Licenses

� XE "Options for upgrading client licenses" �When you plan the migration of PATHWORKS V5 (LAN Manager) to PATHWORKS Advanced Server, assess the environment and decide the best procedure to ensure that clients who need to access the PATHWORKS Advanced Server are sufficiently licensed.  Upgrade options for client-based licenses include:

Individually configure clients to request a Client Access license. 

Remove all LAN Manager licenses and load new Client Access licenses. 

Configure the PATHWORKS (Advanced Server) License Server to automatically upgrade all LAN Manager licenses presented to the PATHWORKS License Server to Client Access licenses.

Option 1

Individually configuring specific clients to request a PATHWORKS Advanced Server license requires modifying the client configuration for the licenses the client requests.  This procedure works best when:

There are very few clients that will access the PATHWORKS Advanced Server.

Migration of clients to using the PATHWORKS  Advanced Server will be slow and done over a long period of time. 

The procedure for configuring clients is described in Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault � in this guide.  

Option 2

This option works best if you are required (or choose) to remove your all your LAN Manager licenses from the license server system.  If some LAN Manager licenses are still needed on your license server system, in addition to new Client Access licenses, refer to Option 3 below.

If the LAN Manager license PAKs are removed from the license server system, all client's which had previously been assigned LAN Manager licenses by this server will automatically have their licenses revoked.  The next time these clients attempt to verify their licenses, they will be informed their previously assigned LAN Manager license is now invalid.  At this point, most client license requesters will automatically attempt to acquire a new LAN Manager license (some older client license requesters may need to be manually re-run again to request a LAN Manager license).

If Client Access licenses have been loaded onto the license server system, the license server, through normal license version look-up procedures, will not find an available LAN Manager license but will find a Client Access license and assign it to the client instead.  See the description in Option 3 (below) for a discussion of what license is actually returned to the client when a client requests a LAN Manager license but is instead assigned a Client Access license.  See Chapter 3, Configuring License Servers, the Controlling License Version Lookup� \Relate "config.doc!30", "Controlling License Version Lookup" \D2HTargetDefault � section in this guide for a discussion of how license lookup works.

Option 3

Configuring the PATHWORKS license server to upgrade licenses affects all clients requesting or verifying a license.  If the PATHWORKS license server is configured to upgrade licenses, LAN Manager client-based licenses are upgraded to an Advanced Server license when either of the following occurs:

A client requests assignment of a license.

A client requests verification of a previously assigned license. 

The PATHWORKS license server automatically assigns the client a Client Access license (even though it has requested assignment or verification of some other LAN Manager license) and returns an equivalent Client Access license to the client.

The upgrade returns “an equivalent Client Access license” to the client; however, the name of the license assigned will not match the name of the license returned to the client. 

For example, if a client requests assignment of a PWLMXXXFP05.00 license from the PATHWORKS license server, the license server  upgrades the request to a Client Access license and assigns a PWLMXXXCA06.00 license (if one is available).  However, the name of the license returned to the client is PWLMXXXFP06.00.  

The reason for this discrepancy is because the client will only accept licenses of the type requested (PWLMXXXFPmm.nn) with the requested or higher version number (05.00 or higher).  To get the client to accept a Client Access license, the license server returns a different name than that assigned. 

�From the client's perspective the license assigned is PWLMXXXFP06.00 and the client will accept that.  From the PATHWORKS license server's perspective (as displayed by the PATHWORKS License Manager), the client was assigned a PWLMXXXCA06.00 license.  Refer to the following table for a list of the names of the licenses returned to clients due to upgrade operations.  



License Requested �License Returned��PWLMDOSCCnn.mm�PWLMDOSCC07.00��PWLMOS2CCnn.mm�PWLMOS2CC07.00��PWLMWNTCCnn.mm�PWLMWNTCC07.00��PWLMXXXFP05.00�PWLMXXXFP06.00��

In cases where the license assigned is different from the license returned to the client, the license server log file contains two messages:

One message indicates the name of the license assigned to the client.

The other message indicates the name of the license returned to the client.

Note:  A license returned to a client that does not match the name of an actual license assigned to the client is sometimes referred to as a "virtual" license.

�Removing LAN Manager Licenses and Loading New Client Access Licenses

� XE "LAN Manager licenses:removing" �� XE "Removing:LAN Manager licenses" �� XE "Loading Client Access licenses" �By default, if a LAN Manager license is requested or an attempt is made to verify it and no LAN Manager licenses are available on the server, the PATHWORKS License Server automatically assigns a Client Access license through the normal process of license version lookup, if one is available (refer to Chapter 3, Configuring License Servers� \Relate "config.doc!4", "Configuring License Servers" \D2HTargetDefault �, in this guide for more information).  The results are the same as if the server was configured to automatically upgrade LAN Manager licenses to Client Access licenses.

Configuring Automatic License Upgrades

� XE "Upgrading licenses:automatic license upgrades" �� XE "License management:upgrading automatically" �By default, the PATHWORKS Advanced Server license server will not perform license upgrades. To configure a PATHWORKS Advanced Server License Server to upgrade licenses to Client Access licenses, follow this procedure:

Load new Client Access licenses on the license server.

Edit the license server start-up command file SYS$Startup:PWRK$License_S_Start.Com to include the following logical name definition:

$ DEFINE PWRK$LS_V6_ACCESS_UPGRADE  1

Be sure to include this command before the following RUN command:

$ RUN SYS$SYSTEM:PWRK$LICENSE_SERVER

If the PWRK$LS_V6_ACCESS_UPGRADE logical is undefined or defined to be zero (0), the license server will not upgrade licenses.  If the PWRK$LS_V6_ACCESS_UPGRADE logical is defined to be any numeric value other than zero, clients requesting assignment or verification of LAN Manager licenses will have their licenses upgraded to Client Access licenses, provided sufficient PATHWORKS Advanced Server Client Access licenses exist.

Also note that when an upgrade operation occurs, the license server will log both the assignment of the PATHWORKS Advanced Server license and the name of the license returned to the client to the license server log file PWRK$Logs:PWRK$License_Server_node-name.LOG.
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Configuring License Servers

Introduction

This section explains some license server configuration changes you may need to make and the impact of those changes on the client(s).  The license server configuration information is explained in the following sections:

License Server State Files� \Relate "config.doc!7", "License Server State Files" \D2HTargetDefault � ( describes the contents of the license server state file and describes how to create a new one. 

Moving a License Server to a Different System� \Relate "config.doc!29", "Moving a License Server to a Different System" \D2HTargetDefault � ( describes the options available to you when you move the license server to a different node. 

Controlling License Version Lookup� \Relate "config.doc!30", "Controlling License Version Lookup" \D2HTargetDefault � ( describes how to control the ‘lookahead’ function of the license server.

Controlling Where the License Server Runs in an OpenVMS Cluster� \Relate "config.doc!31", "Controlling Where the License Server Runs in an OpenVMS Cluster" \D2HTargetDefault � ( describes different configuration options that are available to control which system the license server runs on in an OpenVMS cluster environment.

Synchronizing the License Server Database with the LMF Database� \Relate "config.doc!8", "Synchronizing the License Server Database with the LMF Database" \D2HTargetDefault � ( describes how the database is synchronized with the LMF database updates that have occurred. 

License Server State Files

� XE "License server:state files" ��xe "State file"�The PATHWORKS license server stores information in a database called the license server state file, which exists on the system as: 

PWRK$LICENSE:PWRK$LICENSE_SERVER_STATE.DAT

The information that is stored in the license server state file includes the following:

The names used by the license server that enable LAN Manager and NetWare clients  access to it. 

Information about the types and quantities of client-based licenses that are available to assign to clients.

License group information.

A record of the licenses the license server has assigned to clients. 

The following sections provide information about the license server state file and describe the procedure for recreating it. 

PATHWORKS License Server Names

� XE "License server:names" �The license server state file stores the name of the license server.  This name is used to facilitate communication between the license server and clients.  When a client is assigned a license, part of the license information saved by the client is the name of the license server that issued the license.  This name is used to contact the license server when the client attempts to verify its licenses.

The license server uses two name formats, one for communicating with LAN Manager and Advanced Server clients and one for communicating with NetWare clients.  The names are defined in the following format:  

LAN Manager and Advanced Server�PWRK$Lname��NetWare �PWL_name_PNW ���When the license server is started for the first time, the template license server state file provided during PATHWORKS installation does not contain any license server names.  The license server determines its name as follows: 

On a node in an OpenVMS cluster, where an equivalence-name is defined for the logical SYS$CLUSTER_NODE, the node name portion of the value of the equivalence-name is used as the name portion of the license server names.

On a standalone node, where the logical SYS$CLUSTER_NODE is not defined, the license server uses the value of the SYSGEN SCSNODE parameter as the name portion of the license server names.

In either case, the value chosen as the name portion of the license server names is used to form the license server name, which is then stored in the license server state file.  Once established, the license server uses the name stored in the state file, even if the SYS$CLUSTER_NODE or SCSNODE values should change.

Creating a New License Server State File

� XE "License server:creating state files" �If the license server state file is rendered unusable, the license server will not run.  You must create a new license server state file if this happens.  Follow these steps to create a new license server state file: 

Shut down the license server. 

In a cluster, shut down the license server on all nodes.

If the license server state file exists, delete the current license server state file, or rename it to another filename.

In a cluster, do this on only one node because the state file is common to all nodes.

Restart the license server.

When the license server starts and does not find a license server state file, it creates a new state file, disables itself, and logs a message to the license server log file stating that a new state file has been created and that the license server has disabled itself.  

To enable the license server:

Invoke the PATHWORKS License Manager.  

From the Main menu, choose Options.

From the Options menu, choose Server Enable/Disable.

Choose Enable Server.

Choose OK.

Once enabled, the license server determines its name and initializes the license server state file before it  responds to any client requests.  Refer to Chapter 4, Managing Licenses on the OpenVMS Platform� \Relate "ovms.doc!2", "Managing Licenses on the OpenVMS Platform" \D2HTargetDefault �, in this guide for information about using the License Manager.

Because the license server begins running with a new license server state file, all information from any previous license server state file is lost, including the license server names, any group information, and all records of client licenses which were previously assigned.  If license groups were being used, you must recreate the groups and allocate licenses to them.

When the license server starts with the new state file and determines its name, two possible problems may occur:

The license server name is the same name as was previously used, but license groups are not defined.

In this case, any client that was previously assigned a license by the license server fails on its next attempt to verify the license, because the assignment information stored in the previous state file was lost and the client's license is marked as invalid.  In this case, the client should attempt to acquire a new license after you recreate the licensing groups.

The license server name is different than the name previously used, but the client license data file is not updated.

In this case, clients cannot locate the license server to verify their license because they are attempting to contact the license server using the license server's old name.  You should delete the license data file on the client and reboot it so that it attempts to acquire a new license.  If the PATHWORKS configuration template file specified a license server name, that must be changed.  Then, when the client looks for a new license, it finds its new name, and it can acquire a new license.

Moving a License Server to a Different System

� XE "License server:moving to a different system" �� XE "Moving:license server to a difference system" �There are two recommended methods for changing the system on which the PATHWORKS license server is run.  You can move the license server and retain the same server name or you can move the license server and change the server name.  

When you move the license server and retain the server name, it is transparent to users. Clients will not notice that the license server has moved. 

When you move the license server and change the server name, there is an impact on both server administration and clients:

You must re-enter all license group information on the new system using the License Manager and you must allocate licenses to each of the groups.

The original license server revokes client licenses so clients cannot validate assigned licenses on the new server. 

You must keep the original license server running (even though it does not have any licenses it can assign) until all the clients find the new license server.

The clients must acquire a new license from the new license server.  

Use the following procedures for moving the license server and retaining the server name or moving the license server and changing the server name. 

Moving the License Server and Retaining the License Server Name

� XE "License server:moving and retaining the same name" �� XE "Moving:license server and retaining server name" �For the purposes of this example, the license server is currently running on a system called SYS1 and the license server is to be moved to a system called SYS2, which is not currently running a license server: 

Shut down the license server on SYS1.

Reconfigure PATHWORKS on SYS1 so that the license server is not started when PATHWORKS is started. 

Unload and delete all the PATHWORKS client-based license PAKs from LMF on SYS1.

Register and load all the PATHWORKS client-based license PAKs that were deleted from LMF on SYS1 into LMF on SYS2.

Install PATHWORKS software on SYS2, if not already done.

Configure PATHWORKS on SYS2 to run the license server, but do not start the license server.

Delete any template license server state files on SYS2.  For more information, refer to the License Server State Files� \Relate "config.doc!7", "License Server State Files" \D2HTargetDefault � section in this guide.

Copy the license server state file from the PWRK$LICENSE directory on SYS1 to the PWRK$LICENSE directory on SYS2.

Start the PATHWORKS license server on SYS2.  The license server finds and reads the license server names it was previously using on SYS1 in the state file and continues to use them while running on system SYS2.

Clients that were assigned licenses by the license server running on SYS1 continue to  verify their licenses (or get new licenses) from the license server named “SYS1” running on system SYS2.

Moving the License Server and Changing the License Server Name

� XE "License server:moving and changing the name" �� XE "Moving:license server and changing the name" �For the purposes of this example, the license server is currently running on a system called SYS1 and the license server is to be moved to a system called SYS2, which is not currently running a license server. 

Install PATHWORKS software on SYS2, if not already done.

Configure PATHWORKS on SYS2 to run the license server, but do not start the license server.

Shut down the license server on SYS1.

Unload and delete all the PATHWORKS client-based license PAKs from LMF on SYS1.

Register and load all the PATHWORKS client-based license PAKs that were deleted from LMF on SYS1 into LMF on SYS2.

Start the PATHWORKS license server on SYS2, causing the license server on SYS2 to form the license server names using "SYS2" as the node portion of the license server names.  These new names are stored in the license server state file on SYS2.

Using the PATHWORKS License Manager, load the PATHWORKS product licenses into the license server and define any groups which were defined for the license server on SYS1.  This recreates a similar PATHWORKS license server state file on SYS2 as was on SYS1, with the exception of the client licenses assigned on SYS1.  Refer to Chapter 4, Managing Licenses on OpenVMS Systems� \Relate "ovms.doc!2", " Managing Licenses on OpenVMS Systems" \D2HTargetDefault �, in this guide for information about how to use the License Manager.

Start the PATHWORKS license server on SYS1, causing the license server on SYS1 to synchronize the count of assignable licenses with LMF.  Since all the PATHWORKS client-based licenses have been removed from LMF, all licenses previously assigned by the license server on SYS1 are automatically revoked.

Leave the license server on SYS1 running until all clients who were issued licenses by the license server on SYS1 discover their license have been revoked.  Notification that the license has been revoked and is invalid occurs when clients boot and attempt to verify their license.  After a client's license is revoked, the SYS2 license server can assign a new license.  

It may be necessary to modify the client template license server state files if the license server name SYS1 was specified.

Controlling License Version Lookup

� XE "Controlling:license version lookup" � � XE "Licenses:version lookup" ��xe "Version lookup"�If there are no available licenses for the version of the server that the client requests, the licensing software looks for a license for a higher version.

By default, the software looks for licenses for subsequent major and minor releases up to 4.3 versions beyond the requested version.

For example, if the request is for Version 5.1, and no licenses are available, the license server looks for the following license versions in the LMF database: 

	5.2, 5.3�	6.0, 6.1, ..., 6.3�	7.0, 7.1, ..., 7.3�	8.0, 8.1, …, 8.4

You control the version limits by defining the following logical name in the system wide logical name table before starting the licensing software:

PWRK$LICENSE_VERSION_LIMIT

You can define the logical name in two different formats:

	"+MM.mm"�	"MM.mm"

For MM substitute the major release number; for mm substitute the minor release number.  The + means that the version is incremental.  For example, the highest version searched is the current version plus the incremental version.  Without the +, the release number is the absolute value and the search ends at the specified version.

Example 1:

$ DEFINE/SYSTEM PWRK$LICENSE_VERSION_LIMIT "+1.3"

In this example, the license software looks for licenses for one major release beyond the requested version, and for licenses for point releases up to and including .3.  If the request is for Version 5.1, and no licenses are available, the license server or License Registrar looks for licenses in the LMF for the following versions: 

	5.2, 5.3�	6.0, 6.1, 6.2, 6.3

Example 2:

$ DEFINE/SYSTEM PWRK$LICENSE_VERSION_LIMIT "6.2"

In this example, the license software looks for licenses for major software versions up to and including Version 6, and for licenses for point releases up to and including .2.  If the request is for Version 5.1, and no licenses are available, the license server or License Registrar looks for licenses in the LMF for the following versions: 

	5.2�	6.0, 6.1, 6.2

Acquiring a Different Client-based License than Requested

� XE "Acquiring a different client-based license than requested" �In the case where a client is attempting to acquire a client-based LAN Manager license and no LAN Manager licenses are available on the local system, the license lookup function may find an Advanced Server license for the client if one is available (Advanced Server licenses are valid for accessing both PATHWORKS V5 LAN Manager servers and PATHWORKS V6 Advanced Server servers).

If the license server determines that no LAN Manager licenses are available, the license server will begin the lookup process again, looking for Advanced Server licenses (PWLMXXCAnn.mm).

If the license server finds an available Advanced Server license, it is assigned to the client and returned to the client as a virtual license.  

Controlling Where the License Server Runs in an OpenVMS Cluster

�xe "Controlling:what node the license server runs on"�Installing the license server in an OpenVMS cluster environment provides license service failover in the event that license services terminate on the node running the active license server.

Normally, the license server process (PWRK$LICENSE_S) is started on every node of the OpenVMS cluster that starts PATHWORKS, but only one license server process is active at any one time.  The other license server processes remain dormant until an event, such as system shutdown or a system failure, causes the active license server process to stop.  When the active license server stops, one of the dormant license servers becomes active and continues to provide license services to clients. 

In most cases, Digital Equipment Corporation recommends that you run the license server on all nodes of the cluster that run the PATHWORKS file server, for maximum availability.  The exception is the case where the license server will serve licenses to WAN clients.  Then you will want to limit the license server to running on one node of the cluster.

In an OpenVMS cluster environment, the license server state file is maintained cluster-wide.  The PATHWORKS directory tree starting at PWRK$ROOT must be on a disk that is common to all nodes on the OpenVMS cluster.

There are a number of ways to determine which node is running the active license server:

Use the SHOW SYSTEM command. ( This command displays status information about current processes running on your system.  The active license server process is listed as PWRK$LICENSE_S with the state listed as HIB as shown in the following example:

$ SHOW SYSTEM

Pid      Process Name   State    Pri     I/O       CPU        Page 

	.

	.

	.

00000230 PWRK$LICENSE_S  HIB      6      191   0 00:00:01.67   777 

.

	.

	.

This example shows only the license server process.  A dormant license server is shown with its state indicated as LEF.  When you enter the SHOW SYSTEM command, all of the currently running process on the system are displayed. 

Use the PWSHOW command. ( This command displays information about PATHWORKS processes that are running on the system.  The information is displayed in the same format as the SHOW SYSTEM command produces. 

The PWSHOW command accepts arguments to show processes on a specific node in a cluster and to show all nodes in a cluster as follows:  

PWSHOW CLUSTER ( Shows all PATHWORKS processes running on each node in the OpenVMS cluster.

PWSHOW NODE=nodename ( Shows the PATHWORKS processes running on system nodename in the OpenVMS cluster. 

This command is available after you invoke the PWRK$DEFINE_COMMANDS command procedure.  To invoke this command procedure, enter the following command:

@SYS$UPDATE:PWRK$DEFINE_COMMANDS.COM 

Start the License Manager on a node that is not running the license server and an error message states that the server is running on the nodename system.  The License Manager must be run on the same node as the active license server.

For example, enter the command ADMIN/LICENSE.  If the license server is not running on that node, the following message will display:

Figure �Styleref "BeginChapter"�3�–1   License Server Startup Error Message
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Look in PWRK$LOGS.  

The latest file that matches PWRK$LICENSE_SERVER_OpenVMS_cluster name.LOG (this OpenVMS_cluster name may not be a cluster name, although it most likely is one) is produced by the active license server and displays the message:

License server cluster_alias is now processing LAN Manager license requests on node active_node

You use the TYPE or SEARCH commands to examine the file while it is still open. 

How to Specify When License Servers Run in a Cluster

� XE "Specifying when license servers run in a cluster" �To prevent the license server from running on a particular node, you can add the following logical name definition to that node's startup command procedure:

$ DEFINE/SYSTEM PWRK$LICENSE_SERVER_INHIBIT 1 

Note:  In a cluster environment where all nodes use the same startup procedure, check the node name before executing the DEFINE command.

The following example prevents the license server from running on node SPOT:

$ IF F$TRNLNM("SYS$NODE") .EQS. "SPOT::" THEN -�DEFINE/SYSTEM PWRK$LICENSE_SERVER_INHIBIT 1 

The next example allows the license server to run only on node ROVER:

$ IF F$TRNLNM("SYS$NODE") .NES. "ROVER::" THEN -�DEFINE/SYSTEM PWRK$LICENSE_SERVER_INHIBIT 1 

You can specify the following logical name definition to define which nodes you want the license server to run on.  By default, if this logical is not defined, the license server will run on all nodes.

$ DEFINE/SYSTEM PWRK$LS_LICENSE_NODES “node1, node2, node3”

Each node name that you add to this comma-separated list is a node that is allowed to run the license server.  Any node in your OpenVMS cluster, which is not specified in the list when the logical is defined, will not run the license server.  

Note:  If you define PWRK$LS_LICENSE_NODES, and define  PWRK$LICENSE_SERVER_INHIBIT (described above), the settings you define with PWRK$LS_LICENSE_NODES supersede any settings defined with PWRK$LICENSE_SERVER_INHIBIT. 

Synchronizing the License Server Database with the LMF Database 

� XE "Synchronizing the license server database with LMF" �� XE "License server:synchronizing the database with LMF" �The number of client-based licenses available for a product may change because additional product licenses are added to the LMF database, or existing licenses are unloaded, disabled, deleted, or expired from the LMF database. 

The PATHWORKS license server must check the LMF database to verify license counts for products currently in the license server database.  The license server database is updated to reflect LMF database changes at the following times:  

When the license server is restarted.  

Automatically, once every 24 hours, typically at 00:01 (system time).  Refer to the Scheduling the License Server Database with the LMF� \Relate "config.doc!8", "Scheduling the License Server Database with the LMF" \D2HTargetDefault � section in this guide for more information.

When requested by the License Manager for individual license types.

How License Database Changes Impact the License Server

�xe "License updates :results of "�� XE "Database changes" �After a license database update occurs, the new numbers you see in the PATHWORKS License Manager screens may indicate that you must make some adjustments to your group license allocations. 

Changes made to the number of available client-based licenses impact the license server and clients in the following ways: 

If you add client-based licenses to the license server database, the license server automatically adds them to the Default group.  

If you remove client-based licenses, the license server checks the Default group and each of the other groups and automatically removes unassigned licenses from the groups to match the number of licenses lost.

When the number of licenses removed is greater than the number of unassigned licenses, the license server revokes one or more assigned licenses to satisfy the count. The selection of which licenses to remove is completely arbitrary.  Clients with their licenses revoked have to request new ones.

�xe "License updates :post update tasks "�When licenses have been unloaded or deleted, use one of the following strategies to accommodate client needs: 

Redistribute license allocations among the groups ( If, after an LMF database synchronization, some groups still have extra licenses, consider moving the licenses to groups that need additional licenses to cover client needs.  

Redirect clients to other groups ( If you do not want to change the license allocation for a group, consider redirecting some clients to a group that has available licenses.

Obtain additional licenses ( If the overall number of licenses is no longer equal to or greater than the number of clients, purchase additional licenses and enter them into the LMF database.  You can then allocate them where needed.

Scheduling the LMF Synchronization

� XE "Scheduling the LMF Synchronization" �“LMF Synchronization” refers to the operation that updates the PATHWORKS license server database to reflect the system’s LMF database.  �xe "Scheduling the LMF synchronization"�You can schedule the LMF synchronization to occur when it is most convenient for your system.  By default, the synchronization operation occurs at 00:01 system time.  To specify a different time for the synchronization to occur, define the logical name PWRK$LSLMFSYNCHMINUTES in the system logical name table equal to the number of minutes past midnight that the LMF synchronization occurs.

For example, if you want the LMF synchronization to occur at 4:15 AM, compute the number of minutes after midnight: 

4:15 AM = (4 hours x 60 minutes/hour) + 15 minutes

        = 255 minutes past midnight 

Then add the following line to the system's startup command procedure:

$ DEFINE/SYSTEM PWRK$LSLMFSYNCHMINUTES 255

New synchronization times take effect only after PATHWORKS is restarted after the new value is established.
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Managing Licenses on the OpenVMS Platform

Introduction

This section describes how to configure, start up, and use the PATHWORKS License Manager to manage client licenses from an OpenVMS server.  It discusses the following topics: 

Getting Started with the License Manager� \Relate "ovms.doc!32", "Getting Started with the License Manager" \D2HTargetDefault � ( describes the privileges required to run the License Manager and the command used to start the License Manager.

Configuring the License Server� \Relate "ovms.doc!33", "Configuring the License Server" \D2HTargetDefault � ( describes the errors that occur when the license server is not configured, or when you attempt to run the License Manager on a node that is not running the license server.

Navigating in the PATHWORKS License Manager� \Relate "ovms.doc!34", "Navigating in the PATHWORKS License Manager" \D2HTargetDefault � ( describes how to navigate, with a mouse or keyboard, in the License Manager screens.

Performing License Server Tasks� \Relate "ovms.doc!35", "Performing License Server Tasks" \D2HTargetDefault � ( describes how to start and stop the license server and how to manage the license server log files.

Performing License Product Tasks� \Relate "ovms.doc!36", "Performing License Product Tasks" \D2HTargetDefault � ( describes tasks you perform to manage license products.

Performing License Group Tasks� \Relate "ovms.doc!5", "Performing License Group Tasks" \D2HTargetDefault � ( describes tasks you perform to manage license groups.

Performing Client License Tasks� \Relate "ovms.doc!37", "Performing Client License Tasks" \D2HTargetDefault � ( describes tasks you perform to manage client licenses.

Getting Started with the PATHWORKS License Manager

�xe "License Manager:prerequisites "�The DIGITAL OpenVMS account used to run the PATHWORKS License Manager must have the following privileges:

SYSLCK �xe "SYSLCK privilege"�

TMPMBX�xe "TMPMBX privilege"�

NETMBX�xe "NETMBX privilege"�

Starting the License Manager

�xe "License Manager:starting "�To start the PATHWORKS License Manager, enter the following command from the system where the license server is running: 

$ ADMINISTER/LICENSE_MANAGER

When you start up the PATHWORKS License Manager, the Main menu screen, similar to the one shown in the following figure appears.  �xe "Main menu screen"�

Figure �Styleref "BeginChapter"�4�–1   Main Menu Screen
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The Main menu toolbar contains the following menu items:� XE "License Manager:list of menus" �

View menu ( allows you to select either of the three items you will manipulate with the License Manager:

Products

Groups

Client Licenses

To perform management functions on a product, you choose Products from the View menu and then you choose the function you want to perform from the Actions menu.  The same process is used when performing management functions on Groups or Client Licenses.

Actions menu ( provides functions that you perform on Products, Groups, or Client Licenses depending upon the view you selected.

Options menu ( allows you to enable and disable the license server and to perform Log File options. 

Help menu ( provides information about using the License Manager.

To select a menu, press F10 or PF1 and PF1 again.  The system displays the View menu as shown in the following figure.�xe "Main menu screen:with theView menu displayed"�

Figure �Styleref "BeginChapter"�4�–2   Main Menu with View Menu Displayed
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If you want to display one of the other menus, use the arrow key to move the cursor to that menu or use you mouse.

�

Getting Help with the License Manager

� XE "Getting help" �� XE "Help" �To invoke from the License Manager, from the Main menu bar, choose Help.  The Help menu displays two options:

General Help

Help with this screen

Select the appropriate help option.  To exit the help screen, press Return.  To exit the list of topics, press F10.

Exiting the License Manager

� XE "Exiting" �� XE "License Manager:exiting" �To exit from the License Manager, follow these steps:

From the Main menu bar, choose View.

From the View menu, choose Exit.

Configuring the License Server

� XE "Configuring:the license server" �� XE "License server:configuring" �If you attempt to start the License Manager when the License Server is not running on the system, the message shown in the following figure is displayed:

Figure �Styleref "BeginChapter"�4�–3   License Server Error Message
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If the license server has not been configured, you must reconfigure the PATHWORKS (Advanced Server) software.  Run the initial configuration procedure, PWRK$CONFIG.COM and specify that you want to enable the license server.  For information about configuring the license server or additional information about the PWRK$CONFIG.COM command procedure, refer to the PATHWORKS for OpenVMS Server Installation and Configuration Guide.

In an OpenVMS cluster, if you attempt to start the License Manager on a node that is not running on the active license server and the license server is active on another member of the cluster, the following error appears.� XE "License Server Startup Error Message screen" �

Figure �Styleref "BeginChapter"�4�–4   License Server Startup Error Message
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To run the License Manager, issue the ADMINISTER/LICENSE_MANAGER command on the node that is running the active license server (defined as nodename in the License Server Startup Error Message). 

Navigating in the PATHWORKS License Manager

�xe "License Manager:navigating screens "��xe "License Manager:list of menus "�� XE "Navigating the License Manager" �The following tables describe the keys and  buttons you use to navigate within and between the PATHWORKS License Manager screens. �xe "Keys:for navigating screens:table of"� �xe "Buttons:for navigating screens:table of "� �xe "Screens:navigating the License Manager "�

Table �Styleref "BeginChapter"�4�–�seq tblnum�1�   Keys for Navigating Screens

Use this key...�To...��Arrow keys�Navigate up and down lists and input fields, and across menu options and buttons.��F10 �Select a menu.

PF1, V     To select the View Menu

PF1, A     To select the Actions Menu

PF1, O     To select the Options Menu

PF1, H     To select Help��Comma (keypad)�Enable/disable a selection of multiple lines in a scroll region.  When you perform an action on multiple lines (for example, removing a group), a confirmation box displays with 3 options:

YES                   Confirm the action for each item selected.

YES TO ALL     Perform the action on all selected items.

CANCEL           Cancel the action.��Space bar�Enable or disable the item selection.  Selected items are highlighted.��Tab�Move the cursor from group to group.��Return�Display the screen or dialog box associated after selecting a task.���Remove the message window after an error message has been displayed.��Hot key �Select the menu item list or input field whose hot key is highlighted.  Used with PF1, they are the letters in the menu items that are underlined.  For example, press PF1 G at the View menu for a list of server groups.��

Table �Styleref "BeginChapter"�4�–�seq tblnum�2�   Buttons for Navigating Screens

Use this button...�To...��OK

�Confirm the actions you performed on a particular screen.  After choosing this button in a dialog box associated with a screen, you are returned to the screen.  After choosing this button at the bottom of a screen, you are returned to the previous screen.��Help 

�Display help text.  To exit the screen, press Return.  To exit the list of topics, press F10.��Cancel �Cancel the actions you just performed.��

Navigating Fields in a Dialog Box

When you enter values in a dialog box that has several fields, use the up and down arrow keys to navigate back and forth between the fields.  You can back up through the fields in this way to change a value as long as you have not pressed Return to commit the values.

�Performing License Server Tasks

� XE "License server:using"�License server tasks include managing the license server log files and enabling and disabling the license server.  These tasks are performed through the following Options menu items:

Log File Options …

Server Enable/Disable …

Disabling and Enabling the License Server

� XE "License server:disabling and enabling" �� XE "Enabling:the license server" �� XE "Disabling:the license server" �When you invoke the License Manager, the license server, in most cases, is enabled.  Before you add, move, or remove any licenses within license groups with the License Manager, you should disable the license server.  Otherwise, it is not necessary to disable the license server before performing these operations.  If the license server is enabled while you manage licenses, it can assign the same licenses you are managing, causing unpredictable results. 

Whenever you exit the License Manager, the license server is automatically re-enabled.  

In certain circumstances, if the license server finds no license server state file in the PWRK$LICENSE: directory, the license server disables itself, logs a message in the license server log file and operator console, creates the default license server state file, and remains disabled until the License Manager enables it.  For additional information about the license server state file, refer to License Server State Files� \Relate "config.doc!7", "License Server State Files" \D2HTargetDefault � in this guide.

To disable or enable a license server, follow these steps:

From the Main menu bar, choose Options.

From the Options menu, choose Server Enable/Disable …

The Server screen shown in the following figure appears.�xe "Server Options screen"�� XE "Server Enable/Disable screen" �

Figure �Styleref "BeginChapter"�4�–5   Server Enable/Disable Screen
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Choose either Enable Server or Disable Server.  An asterisk next to the option means that the option is selected. 

Press Return or choose the OK button to complete the operation and return to the Main menu. 

Performing Log File Tasks

� XE "License server:log file tasks" �� XE "License server:log file tasks" ��xe "Log events:enabling and disabling "�You can perform the following log file tasks using the License Manager:

Choose which license server events to record in the license server log file.

Create a new version of the server log file.

�xe "Log files:location "�You can read or purge old versions of the server log file as you would any OpenVMS file.  The file name and location is: 

PWRK$LOGS:PWRK$LICENSE_SERVER_servername.LOG

PWRK$LOGS is defined in the system logical name table when PATHWORKS is started.  The servername is usually the OpenVMS Cluster alias or the node name of the system  the license server is running on.  For example, if your node is NASCAR, the file name and location is: 

PWRK$LOGS:PWRK$LICENSE_SERVER_NASCAR.LOG 

Enabling Events for Logging

� XE "Enabling:events for logging" �� XE "License server:enabling events for logging" �You can enable logging for events associated with the following operations:

Successful license requests 

Failed license requests*

License verifications

Verification requests denied*

Licenses released

Server startup* (Note that you cannot change this.)

License alert event*

Client address changes*

Client ID changes*

Server enable/disable actions

Licenses revoked*

Fatal server error* (Note that you cannot change this.)

*Note:  These events have logging enabled by default when the license server is first started.

You can disable the logging of all events except server startup and fatal server errors.  

If you are experiencing any problems with the license management software, Digital Equipment Corporation recommends you enable the logging of all types of license server events.  This will provide you with a comprehensive log file that provides information to assist in troubleshooting licensing problems.

Selecting Events for Logging

� XE "Log files:selecting events for logging" �� XE "License server:selecting events for logging" �To select the events you want to log, follow these steps:

From the Main menu bar, choose Options.

From the Options menu, choose Log File Options ...

A  screen similar to the one shown in the following figure appears.�xe "Log File Options screen"�

Figure �Styleref "BeginChapter"�4�–6   Log File Options Screen
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Select the events for which you want to enable or disable logging.

Using the space bar or the mouse, toggle the event to either enabled or disabled.

A mark (X) next to the event indicates that the event is enabled.  You cannot disable server startup events or fatal server error events.

�Choose OK to confirm or one of the following options:

Option�Description��Cancel�Cancel your selections.��Clear All�Clear all settings.��Select All�Select all settings.��Help�Get help on log file options. ��Start New Logfile�Create a new logfile instead of continuing to append information to the existing logfile.  The logfile can become long.  This option allows you to start a logfile from today.��

Creating a New Version of the Log File

� XE "Log files:creating a new version" �� XE "License server:creating a new version of the log file" �A log file can grow quickly when tracking many events.  When a log file becomes too large, you can create a new version of the file. 

To create a new version of the log file, follow these steps:

From the Main menu bar, choose Options.

From the Options menu, choose Log File Options ...

From the Log File Options screen, choose Start New Log File.

Choose OK in the Confirmation screen.

Choose OK in the Log File Options screen.

�Performing License Product Tasks

� XE "License server:license product tasks" ��xe "Product licenses:tasks related to "��xe "Product licenses:See also Licenses "�You can use the License Manager to perform the following product license tasks.

Add product licenses to the license server

Remove product licenses from the license server

Display the groups that have licenses allocated from a specific product

Set alert levels for product licenses

Generate product reports

Sort the display of products in the License Manager

Adding Product Licenses

� XE "Adding product licenses" �� XE "License server:adding product licenses" ��xe "Product licenses:adding to the license manager "�� XE "Licenses:adding product licenses" �To add new or additional product licenses to the PATHWORKS license server, follow these steps: 

From the View menu, choose Products.

From the Main menu bar, choose Actions.

From the Actions menu, choose Add ... 

The Add PATHWORKS License Product screen shown in the following figure appears.�xe "Add PATHWORKS License Product screen"�

Figure �Styleref "BeginChapter"�4�–7   Add PATHWORKS License Product Screen
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Enter the license product name in the text entry field.

Example:  PWLMXXXCA06.00

Choose OK.

You can use the same procedure to add additional product licenses later.

Removing Product Licenses

� XE "Removing:product licenses" ��xe "Licenses:removing all licenses for a product"�When a product is no longer needed, remove its licenses. �xe "Product licenses:removing "� You cannot remove a single license for the product with the License Manager; you must remove the product that removes all licenses.  

Note:  When removing the product licenses from the PATHWORKS License Manager, first remove them from the LMF database as described in the OpenVMS License Management Utility Manual.  If you do not remove the licenses from the LMF database, they may continue to be assigned to clients.

Removing all licenses for a product from the PATHWORKS License Manager and the LMF database prevents clients from acquiring a license the next time they try.  If removed licenses are currently assigned to clients, those licenses are revoked and the client is informed that the license was revoked the next time the client attempts to verify the license.

To remove all licenses for a product, follow these steps:

Remove the licenses from the LMF database as described in the OpenVMS  License Management Utility Manual.

From the View menu, choose Products.

From the List of PATHWORKS License Products screen, choose the product you want to remove.  

From the Actions menu, choose Remove.

A dialog box appears in which you can confirm or cancel the removal.

Choose the OK button to confirm the removal.

Listing Product Allocations

� XE "Listing:product allocations" �� XE "Product allocations:listing" �� XE "License server:listing product allocations" �To display the groups that have licenses allocated from a specific product, perform the following steps:

From the View menu, choose Products.

From the List of PATHWORKS License Products screen, choose the product you want to display allocation details for.

From the Actions menu, choose Show Details (or double-click on the product).

The system displays a list of groups that have allocations of the selected product. 

Choose OK to confirm and return to the Main menu.

Setting the Alert Level for Product Licenses

� XE "Setting the alert level:for product licenses" �� XE "License server:setting the alert level for product licenses" �To set the alert level for product licenses, perform the following steps:

From the View menu, choose Products.

From the List of PATHWORKS License Products screen, choose the product you want to set the alert level for.

From the Actions menu, choose Modify.

Set the alert level.  If the alert level is set to zero (0), you will not receive an alert when no licenses are available.  The maximum value you can set the alert level to is the total number of licenses.  As you manage licenses, you want to set the alert level to the number that make most sense in your environment.  When the number of licenses drops to this level, you receive an alert.

When the number of assigned licenses reaches this value, an entry is added to the license server log file.  Refer to Appendix B, Server Messages� \Relate "smess.doc!9", "Server Messages" \D2HTargetDefault �, in this guide for more information.

Choose OK to confirm and return to the Main menu.

Generating Product Reports

� XE "Product reports:generating" �� XE "License server:generating product reports" �� XE "Reports:for products" �� XE "Generating reports:for products" �To generate a product report, follow these steps:

From the View menu, choose Products.

From the List of PATHWORKS License Products screen, choose the product you want to generate a report for.

From the Actions menu, choose Generate Product Report.

The system displays the File Name dialog box.

Enter the name for the report in the File Name dialog box. 

Choose OK to confirm and return to the Main menu.

By default, the report is written to the current default directory, unless another directory is specified in the File Name dialog box. 

Sorting Product Displays

� XE "Sorting:product displays" �� XE "Product displays:sorting" �� XE "License server:sorting product displays" �You can sort the display of the products in the List of PATHWORKS License Products screen.  You can sort by:

Product name

Licenses available

Licenses in use

By default, the list of products are displayed by product name.  Use the following steps to specify a different sort option:

From the View menu, choose Products.

From the Actions menu, choose Sort By …

The system displays the Sort Options for Products screen shown in the following figure. � XE "Sort Options:for Products screen" �

Choose the sort option you want.

Choose OK.

Figure �Styleref "BeginChapter"�4�–8   Sort Options for Products Screen
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�Performing License Group Tasks

� XE "License groups:tasks" �� XE "License server:license group tasks" �You can use the License Manager to perform the following license group tasks. 

Create license groups

Allocate licenses for a product to a group

List the clients in a license group

List the product licenses that a group has licenses allocated from, and how many such licenses are in use

Move or remove licenses from a group

Remove a group

Set the alert level for licenses in a group

Generate group reports

Sort the display of groups in the License Manager

Creating License Groups

� XE "License groups:creating" �� XE "License server:creating license groups" �� XE "Creating license groups" �When PATHWORKS (Advanced Server) software is initially installed, the Default group and the Server-Based group are created automatically.  Any license products that are loaded onto the system are automatically placed in the Default group.  To enable server-based licensing, you must allocate licenses from the Default group to the Server-based group.

You can create user-defined license groups.  These additional groups are for client-based licensing and are used to organize the distribution of licenses.  The groups you create typically reflect the organizations that you support.  For example, you may create the groups Engineering, Finance, and Marketing because these are the organizations you support.  To utilize these groups, client software is configured so that a license is requested from that group. 

To create a group, follow these steps:

From the Main menu bar, choose View.  

From the View menu, choose Groups.

From the Actions menu, choose Add.

The dialog box shown in the following figure appears. �xe "New Group or Product screen"�

�Figure �Styleref "BeginChapter"�4�–9   Add New Group Screen
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Enter the name of the group you wish to create, and choose OK. 

When you create a group, the license allocation is set to zero.  You must use the Modify Group function to allocate licenses to the new group. 

Listing Licenses in a Group

� XE "Listing:licenses in a group" �� XE "License server:listing licenses in a group" ��xe "License groups:listing clients "�You can use the License Manager to determine how many licenses from each product have been assigned to each group.  To list how many licenses have been assigned to a specific group, follow these steps:

From the View menu, choose Groups.

From the List of PATHWORKS License Groups screen, choose a Group.

From the Actions menu, choose Show Details (or double-click on the group).

The Clients screen similar to the one shown in the following figure appears. �xe "Clients in a Group screen"�

�Figure �Styleref "BeginChapter"�4�–10   Clients Screen for Clients in a Group
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Allocating Licenses to a Group

� XE "Allocating licenses:to a group" �� XE "Groups:allocating licenses" ��xe "License groups:allocating licenses to "��xe "Allocating licenses:to a license group"��xe "Licenses:allocating to a group "�When you create a group, no licenses are automatically allocated to it.  To allocate licenses to a group, you move them from the Default group to the group you want them in.  You can allocate licenses at any time to any group except the Default group. 

Note:  You cannot allocate licenses to the Default group.  If you specify a product under the Default group, you can set only its alert level in this dialog box.

To allocate licenses to a group, follow these steps: 

From the View menu, choose Groups.

From the List of PATHWORKS License Groups screen, choose the group that you want to allocate licenses to.

From the Actions menu, choose Modify ...

The system displays the dialog box shown in the following figure.�xe "Modify License Product Allocation screen"�  

�Figure �Styleref "BeginChapter"�4�–11   Modify License Product Allocation Screen 
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Each field in the dialog box is displayed with a value.  You can change the allocation and alert fields. � XE "Allocation and alert field descriptions:table of" �

Table �Styleref "BeginChapter"�4�–�seq tblnum�3�   Allocation and Alert Field Descriptions

Field�Description��Product �The name of the product you chose.  You cannot alter this field.��Max�The number of licenses in the Default group that are available for you to allocate to the group. �xe "Allocating licenses:to a license group, entering values for "� If there are no available licenses for the product, the value of this field is 0.  You cannot alter this field.��Alert�The number of licenses of this product allocated to this group that triggers a message warning you that the licenses used have reached this level.  For example, if you have 100 product licenses allocated to the Services Group and have set the alert level to 90, when you have used the 90th license of this product in the Service Group, you receive a message warning message.��Allocation

�The number of licenses you want to allocate to the group.  If licenses have been previously allocated, the value displayed for this field tells you how many.  If no licenses have been previously issued, the value displayed is 0.  

You can change this number to any number from 0 to the number indicated in the maximum field.  If you decrease the number, the difference is returned to the Default group.  If you increase the number, the increment is deducted from the Default group.  

To allocate licenses, add a number to the value displayed for this field that is equal to or less than the value of the maximum “Licenses available to issue” field. 

Note: You cannot allocate more licenses to the group than are available from the Default group.  However, you can add the available licenses in the Default group to any that you have already issued.��

When you have finished entering values, press Return and choose OK.

Re-allocating Licenses to Another Group

� XE "Re-allocating licenses" �� XE "Groups:re-allocating licenses" ��xe "License groups:moving licenses from one group to another "��xe "Licenses:moving to another group "�If you have excess licenses in one group and not enough in another, you may want to change license allocations.  To re-allocate licenses, you move licenses from one group to the Default group and then allocate the licenses in the Default group to another group. 

To re-allocate licenses to another group, follow these steps: 

From the Main menu bar, choose View.

From the View menu, choose Groups. 

From the list of groups displayed in the Main screen, choose the group that you want to remove licenses from.

From the Main menu bar, choose Actions.

From the Actions menu, choose Modify ...

The system displays the Product Allocation screen.  

Modify the license allocation and choose OK.

The licenses that you remove are returned to the Default group.  The main screen re-displays.

From the Product Allocation screen, choose the group that you want to increase the number of licenses allocated to. 

From the Actions menu, choose Modify ...

In the Product Allocation screen, increase the number of licenses allocated to the group and choose OK.  

Removing Groups

� XE "Removing:groups" �� XE "Groups:removing" ��xe "License groups:removing "�Removing a group deletes the group and causes the following actions: 

Assigned licenses held by clients from that group are revoked.  

All licenses allocated to that group return to the Default group.

Clients can no longer be assigned licenses from that group.

Note:  Clients that request licenses from this group must be reconfigured to request licenses from a different group.  Refer to Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault �, in this guide for more information.

To remove a group, follow these steps:

From the View menu, choose Groups. 

From the List of PATHWORKS License Groups screen, choose the group you want to remove.

From the Actions menu, choose Remove.

The system displays the Confirm Group Removal dialog box.

Choose Yes to remove the group.

Note:  �xe "Default group"�Any user-defined license group can be removed; the pre-defined Default group and the Server-Based license group cannot be removed.  Removing a license group has the following consequences:  (1) any licenses from the selected group that have been assigned to clients are revoked and (2) all licenses allocated to the group you are removing are redistributed back to the Default license group.

Setting the Alert Levels for Groups

� XE "Setting the alert level:for groups" �� XE "Groups:setting the alert level" �To set the alert levels, follow these steps:

From the View menu, choose Groups. 

From the List of PATHWORKS License Groups screen, choose the group you want to set the alert level for.

From the Actions menu, choose Modify.

Set the alert level.

Choose OK to confirm and return to the Main menu

Note:  You cannot set the alert level for the Server-Based group of licenses.

Generating Group Reports

� XE "Groups:generating reports" �� XE "Reports:for groups" �� XE "Generating reports:for groups" �To generate group reports, follow these steps:

From the View menu, choose Groups.

From the List of PATHWORKS License Groups screen, choose the group you want to generate a report for.

From the Actions menu, choose Generate Group Report.

The system displays the File Name dialog box.

Enter the name for the report in the File Name dialog box.

Choose OK to confirm and return to the Main menu. 

By default, the report is written to the current default directory, unless another directory is specified in the File Name dialog box. 

Sorting Group Displays

� XE "Sorting:group displays" �� XE "Groups:sorting displays" �You can sort the display of the groups by:

Product name

Licenses available

Licenses in use

To specify a sort, follow these steps:

From the View menu, choose Groups.

From the Actions menu, choose Sort By …

The system displays the Sort Options for Groups screen shown in the following figure.� XE "Sort Options:for Groups screen" �

�Figure �Styleref "BeginChapter"�4�–12   Sort Options for Groups Screen
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Choose the sort option you want.

Choose OK.

�Performing Client License Tasks

� XE "Client license tasks" �Details about a client are available to the PATHWORKS License Manager when the client is assigned a license or when an existing license is verified.  If a client does not have a user name as configured by the PATHWORKS Client Configuration utility (PWSETUP), the client appears as <noname> in the screen displays.

You can perform the following client-related tasks: 

Revoke a client license

Show details about a client

Sort the display of current clients

Generate a client report

Revoking Client Licenses

� XE "Revoking client licenses" ��xe "Licenses:revoking a client's license "�When you revoke a client's license, you can re-assign the license to another client or to the same client the next time the client requests a license from that group.  When a client's license is revoked, the client must request a new one to access the PATHWORKS server again.

You may want to revoke a client's license for any of the following reasons:

The client moved to a new organization.

The client was assigned a license from the wrong group.

The client's hardware configuration has changed.  

To revoke a license assigned to a client, follow these steps:

From the View menu, choose Client Licenses.

The system displays the List of PATHWORKS Client Licenses screen as shown in the �

Figure �Styleref "BeginChapter"�4�–13   List of PATHWORKS Client Licenses Screen
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Select the client license you want to revoke.  Make sure the client with the desired product is selected (highlighted).

From the Actions menu, choose Revoke.

The system displays the Confirm Revocation of Client License dialog box as shown in the following figure. �xe "Confirm Revocation of Client screen"�

Figure �Styleref "BeginChapter"�4�–14   Confirm Revocation of Client License Screen 
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Choose Yes to revoke the license.

Showing Client Details

� XE "Showing client details" �You can show the following detailed information about each client.  These details are gathered when the client workstation requests a license from the license server.� XE "Client details:field description, table of" �

Table �Styleref "BeginChapter"�4�–�seq tblnum�4�   Client Details Field Description 

Name�Meaning��Client Name�The name of the client.��Client ID�The unique client identifier (most often the address from a network adapter card in the client system).��User name�The user name configured with the PATHWORKS Client Configuration utility.��NetBIOS name�The machine name of the workstation.��TCP/IP host�The name of the TCP/IP client node.��DECnet node�The name of the DECnet client.��Product�The license product assigned to the client.��Group�The group name from which the license was assigned.��Timestamp�The date and time the license was issued. ��

To show details for a client, follow these steps:

From the View menu, choose Client Licenses.

From the List of PATHWORKS Client Licenses screen, choose the client for which you want to show details.

From the Actions menu, choose Show Details (or double-click on the client).

Detailed information for that client, similar to that shown in the following figure appears. �xe "Client details:screen"�

�Figure �Styleref "BeginChapter"�4�–15   Client Details Screen 
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Sorting Client License Lists

� XE "Sorting:client license lists" �You can sort the order in which clients are displayed in the List of PATHWORKS Client Licenses screen.  To specify a sort order, follow these steps:

From the View menu, choose Client Licenses.

From the Actions menu, choose Sort By ...

The system displays the Sort Option for Licenses dialog box shown in the following figure. �xe "Sort Options:for Licenses screen"�

Figure �Styleref "BeginChapter"�4�–16   Sort Options for Licenses Screen 
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Choose the sort option you want and select OK.

Generating Client License Reports

� XE "Generating reports:for client licenses" �� XE "Reports:for client licenses" �You can generate client license reports showing all client licenses that are currently in use.  The information provided is a current summary of the List of PATHWORKS Client Licenses screen and includes:

Client name

User name

Product

Group

Timestamp

You can change the order of the client license information by using the Sort option as described in the Sorting Client License Lists� \Relate "ovms.doc!46", "Sorting Client License Lists" \D2HTargetDefault � section in this guide.  To generate a client license report, follow these steps:

From the View menu, choose Client Licenses.

From the Actions menu, choose Generate Client Report.

The system displays the File Name for Report dialog box shown in the following screen. � XE "File Name for Report dialog box" �

Figure �Styleref "BeginChapter"�4�–17   File Name for Report Dialog Box
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Enter the name for the report in the dialog box and choose OK.

Unless a directory is included in the file name, the report is placed in the current default directory. 

��� INCLUDETEXT d:\\license\\client.doc \* MERGEFORMAT �� Seq D2HDocument \h \r8 �� seq Chapters \r5 �5�

Configuring Client Software

Introduction

� XE "Client software:configuring" �� XE "Configuring:client software" �This section describes the PATHWORKS licensing software that runs on the client computer and communicate with the licensing software components (License Registrar and license server).  The server software components are described in Chapter 1, How to Use PATHWORKS License Software� \Relate "using.doc!2", "How to Use PATHWORKS License Software" \D2HTargetDefault � in this guide.

This section includes the following topics:

When to Install the DIGITAL PATHWORKS Licensing Software� \Relate "client.doc!38", "When to Install the DIGITAL PATHWORKS Licensing Software" \D2HTargetDefault � – describes the situations under which the client computer requires the licensing software components.

How to Install and Start the DIGITAL PATHWORKS Licensing Software� \Relate "client.doc!39", "How to Install and Start the DIGITAL PATHWORKS Licensing Software" \D2HTargetDefault � – describes the procedure for obtaining the licensing software components and how to install them.  It also describes how to enter the licensing software parameters for each type of client computer.

Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � – describes how to configure the client computer to access a license server that is not in the same local area network (LAN).

Obtaining Client-Based Licenses over WANs� \Relate "client.doc!48", "Obtaining Client-Based Licenses over WANs" \D2HTargetDefault � – describes how to configure licensing software on client computers that are not in the same local area network with the license server.

When to Install the DIGITAL PATHWORKS Licensing Software

� XE "Install:when to install licensing software" �To obtain a client-based license from the DIGITAL PATHWORKS for OpenVMS license server, the client computer must be running the software for license acquisition (the PATHWORKS licensing software).  This software enables the client computer to request and store a license key for access to the PATHWORKS file and print server.

Note:  If the client will be accessing the servers using a server-based license, the software components described in this section are not required.  Therefore, you need not follow the procedures described in this section.

PATHWORKS client license components include:

Client License Transponder (CLT)

Client License Requester (CLR)

The CLR works with PATHWORKS license servers to assign licenses to your client system.  It also checks with the license server at startup time to see if the license has been revoked by the network administrator.  The CLT stores the assigned licenses and presents them to the PATHWORKS file server when asked.  For a detailed description of the software process, refer to Appendix C, PATHWORKS Licensing Software Licensing Process� \Relate "licsw.doc!10", "PATHWORKS Licensing Software Licensing Process" \D2HTargetDefault �, in this guide.

The following sections describe the implementation of these components on the following types of client computers:

DOS and Windows clients (with or without PATHWORKS for DOS and Windows client software)

Windows for Workgroups clients (with or without PATHWORKS for DOS and Windows software)

Windows 95 clients (with or without PATHWORKS 32 client software)

Windows NT Version 3.51 clients (with or without PATHWORKS for Windows NT client software)

OS/2 clients (with or without PATHWORKS for OS/2 client software)

Clients use the same transports to obtain and use their license keys as they do to access their file services.  There are many differences between the way that license management works when using the NetWare server and the LAN Manager Server or Advanced Server.  These differences are noted in the following sections as they apply.

� XE "Dial-up connection" �For clients connecting to the server using a dial-up connection, or from a local area network (LAN) other than the server’s LAN, extra steps may be required to obtain a license.  Procedures for these connections are described in the sections specific to each client type in this guide.

�

How to Install and Start the DIGITAL PATHWORKS Licensing Software

� XE "Install:how to install licensing software" �You can install the licensing software on the client computer as follows:

If the client computer is running PATHWORKS client software (such as PATHWORKS 32), the client licensing components may be automatically installed as part of the default client software installation.

If the client computer is not running PATHWORKS client software, the PATHWORKS licensing software can be obtained from Digital Equipment Corporation.

Installing and Starting the Client License Transponder

�xe "Client license transponder:description of"�� XE "Starting:the client license transponder" �The client license transponder (CLT) component resides on the client computer and responds to the PATHWORKS License Registrar software running on the license server system, but it never initiates communication.  The CLT starts the assigned licenses and presents them to the PATHWORKS file server when requested.  The CLT is loaded into upper memory, expanded memory, or extended memory, depending on the configuration of the client.  Depending on the type of client computer, the CLT software component appears as one of the following:

For DOS and Windows clients and OS/2 clients, the CLT program is one of the following:

PWLICLMT.EXE (for LAN Manager)

PWLICNWT.EXE (for NetWare)

For Windows for Workgroups (LAN Manager), the CLT is DECLICL.VXD.  For NetWare, the Windows for Workgroups client runs PWLICNWT.EXE in real mode.

For Windows 95 and Windows NT computers (LAN Manager), the CLT is PNLT32.EXE.  For NetWare, these computers run PILT32M.EXE (Microsoft NetWare) or PILT32N.EXE (Novell NetWare).

In most cases, the CLT starts and runs automatically when the computer starts and requires no manual procedures.

Installing and Starting the Client License Requester

� XE "Starting:the client license requester" �The client license requester (CLR) runs on  the client computer and requests a license from the license server.  This component communicates with the PATHWORKS license server only.  The CLR requests client-based licenses from the PATHWORKS license server and writes the license information to the licensing data file and to CLT memory.  The licensing data file is PWLICLM.DAT for LAN Manager clients, or PWLICNW.DAT for NetWare clients.

If the client computer is running PATHWORKS client software, the CLR may be installed by default as part of the PATHWORKS client software installation.  If the client computer is not running PATHWORKS client software, you install the CLR according the README.TXT file provided with the PATHWORKS Licensing Software kit.

The CLR may require certain information to complete the licensing process.  You supply this information and control the licensing operation by setting licensing software parameters.  The method for setting licensing software parameters depends on the type of client computer.  The following sections describe how to specify the licensing software parameters on each type of client computer.

Depending on the type of client software, the parameters for the licensing software may be supplied in the following ways:

For client computers running PATHWORKS for DOS and Windows software, the PATHWORKS client software provides the PATHWORKS configuration template file.  This file allows you to specify the licensing software parameters as well as the list of licenses to request.  Refer to the PATHWORKS Configuration Template File� \Relate "client.doc!11", "PATHWORKS Configuration Template File" \D2HTargetDefault � section in this guide for more information.

For DOS and Windows, OS/2, or Windows for Workgroups clients, you can use the license configuration file to specify the licenses to request.  Refer to the License Configuration File� \Relate "client.doc!12", "License Configuration File" \D2HTargetDefault � section in this guide for more information.

For DOS and Windows clients and OS/2 clients, you can use the CLR startup command, which supports switches that allow you to specify licensing software parameters.  Refer to Setting the Licensing Software Parameters on DOS and Windows or OS/2 Clients� \Relate "client.doc!14", "Licensing Software Parameters on DOS and Windows or OS/2 Clients" \D2HTargetDefault � section in this guide for more information.

On Windows 95 clients and Windows NT computers, the licensing software parameters are set using the Licensing Software Properties dialog box, as described in the Specifying Licensing Software Parameters on Windows 95 and Windows NT Computers� \Relate "client.doc!13", "Specifying Licensing Software Parameters on Windows 95 and Windows NT Computers" \D2HTargetDefault � section in this guide.

For details on the way the CLR process determines the license server and product licenses to request, refer to Appendix C, PATHWORKS Licensing Software Licensing Process� \Relate "licsw.doc!10", "PATHWORKS Licensing Software Licensing Process" \D2HTargetDefault �, in this guide.

�Specifying Licensing Software Parameters on DOS and Windows or OS/2 Clients

On DOS and Windows clients, and on OS/2 clients, the CLR software component appears as PWLICLM.EXE (for LAN Manager networking) or PWLICNW.EXE (for NetWare networking).  The licensing software parameters can be supplied in the following ways:

You can specify the licensing software parameters on the CLR startup command line.

For a client computer running PATHWORKS for DOS and Windows, you can supply the licensing parameters in the PATHWORKS configuration template file, as described in the License Configuration File� \Relate "client.doc!12", "License Configuration File" \D2HTargetDefault � section in this guide.

You can run the client license requester program manually, to troubleshoot or tune the licensing process, or to override default values for the licensing software parameters. This is useful when operating over a WAN (see the Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � section in this guide) and when connecting to the server using a dial-up connection.  To run the CLR from DOS, use the following syntax: �xe "PWLICLM.EXE program:command syntax "� �xe "Client license requester:program, command syntax "� �xe "PWLICLM.EXE program See also Client license requester program "�

PWLICLM [server_name] [/switches] (for LAN Manager)

PWLICNW [server_name] [/switches] (for NetWare)

The parameters you can supply for the PWLICLM and PWLICNW commands are described in the following table.

Table �styleref "BeginChapter"�5�–1   Client License Requester Parameters for DOS and Windows Clients and for OS/2 Clients� XE "Client license requester:parameters for DOS and Window clients, table of" �� XE "Client license requester:parameters for OS/2 clients, table of" �

Parameter for DOS and Windows Clients�Parameter for OS/2 Clients�

Description��server_name�server_name�Specifies the license server system name.  The named server will be the first server asked for new licenses.

You must supply the license server node name to allow the client to access a license server that is not in the client’s local area network (LAN).  For more information about how to configure clients for wide area network access, refer to Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � in this guide.��/CURRENT:dirpath�or�/I:dirpath�Not available.�Specifies the directory containing the license data file.  This file stores the assigned licenses for the next time the network is started and is located on the client computer.  If not specified, the directory where the CLR is running is assumed.��/GROUP:group�/GROUP:group�Specifies the client's license group.  If not specified, new licenses will be acquired from the license group named “default.”��/NEEDED:filepath�or�/FILE:filepath�/FILE=filepath�Specifies the license configuration file, which contains a list of required licenses.  Refer to the License Configuration File� \Relate "client.doc!12", "License Configuration File" \D2HTargetDefault � section in this guide for more information.��/NOCONNECTION�Not available�Loads any previously assigned licenses, but does not attempt to validate them or acquire new licenses.  For use with dial-up clients.  You must run the CLR again when the network has been connected, to validate the licenses and acquire new licenses.��/NOLOGO�Not available�Suppresses the copyright banner.��/SHOW�/SHOW�Displays all licenses currently assigned to this client.  Do not use any other switches with /SHOW.��/SERVERS�Not available�Displays all available license servers.  Do not use any other switches with /SERVERS.��/TIMEOUT:seconds

Default=3�/T=seconds

Default=5�Specifies the maximum time (in seconds) to wait for a response from the PATHWORKS license server when requesting a license��/PWACCESS�Not available�Sets ERRORLEVEL to 0 if CCS, FPA, or Designated Access licenses are present.  Used in a .BAT file to test for successful assignment of a license to access PATHWORKS servers.  For example:

PWLICLM /GROUP:LGROUP1�PWLICLM /PWACCESS�IF ERRORLEVEL 0 GOTO SUCCESS��/VERBOSE�Not available�Displays more messages during startup, including the current license, licenses needed, and licenses released.��/? or /HELP�/?�Displays information about the CLR startup command.��

License Configuration File

� XE "License configuration file:description of" �The license configuration file lists the licenses that will be requested from the license server.

You can specify a license configuration file at the command line on DOS and Windows clients as well as OS/2 clients, to override the default settings and the settings in the PATHWORKS configuration template file.  Use the /NEEDED switch or the /FILE switch on the CLR startup command, to specify the name and location of the license configuration file.

For example, for LAN Manager enter:

PWLICLM/NEEDED:LICFILE.TXT 

The license configuration file is a text file containing up to 10 entries, where each entry is written in the following format: 

LICENSE0n = DECproduct-name 

Where the value for:

n is a unique number between zero and nine.

DEC is the producer name.

product-name is found on the PAK containing the license that the client will request.  Refer to the License Product Name Definition� \Relate "client.doc!47", "License Product Name Definition" \D2HTargetDefault � section in this guide for more information.

The following is an example of a license configuration file containing two entries.  That is, this client requests two separate licenses.  The two licenses requested are:

PATHWORKS Version 6.0 for OpenVMS (Advanced Server) Client Access (CA)

PATHWORKS 32 Version 7.0 System

The file licfile.txt would then contain the following entries:

LICENSE00 = DECPWLMXXXCA06.00

LICENSE01 = DECPWXXXWINAT07.00

License Product Name Definition

� XE "License product name definition" �The product name on the license PAK indicates the license type that the client requests from the file server.  The product name is found on the PAK that was loaded into LMF on the license server and is one of the major data components that LMF requires.  PATHWORKS PAK product names take the following form:

DECPWaaaaaaabb.cc

�Where the portions of the license PAK name are:

Item�Meaning��DEC�Producer name��PW�PATHWORKS prefix��aaaaaaa�License type ��bb�Major version��cc�Minor version��Note:  Current or newer licenses are backward-compatible.

PATHWORKS Configuration Template File

� XE "PATHWORKS configuration:template file:description of" �When a client is running DIGITAL PATHWORKS for DOS and Windows software, the PWSETUP program creates the PATHWORKS configuration template file, which you can use to specify the licensing software parameters (group, server, and so forth) as well as the licenses to request.

The client requests a specific license type from the PATHWORKS license server based on how the client is configured by the PWSETUP program�xe "Configuration template file:description of"��xe "Configuration utility"�.  You can modify the client configuration so that it requests a different license type, license group, or PATHWORKS license server by modifying the PATHWORKS configuration template file (CFGxxxx.TPL).  The licensing software configuration parameters that you specify in this template file override the automatic selection by the PWSETUP program.  If the user does not specify a configuration file at startup, the client license requester (CLR) looks for a license entry in the configuration template file.  If the PATHWORKS configuration template file contains a license entry, licensing is determined by that template entry.

When a user selects the PATHWORKS configuration template, all licensing information is included with it.  The CLR reads this file to determine whether it needs to modify its license request list.  For more information about the way the licensing software determines what licenses to request, refer to Appendix C, PATHWORKS Licensing Software Licensing Process� \Relate "licsw.doc!10", "PATHWORKS Licensing Software Licensing Process" \D2HTargetDefault �, in this guide.

License configuration parameters are read from the file pointed to by the PWTPL environment variable if the PCSA environment variable is set.  To display the value of the PWTPL variable, at the DOS prompt enter the SET command with no parameters.

The following table describes the licensing template parameters.

�Table �styleref "BeginChapter"�5�–2   PATHWORKS Configuration Template File Parameters � XE "License configuration:template file parameters" �

Parameter�Description��LICCOUNT=n�Specifies the number of licenses to be loaded.��LICENSE00=DECproduct-name 

through 

LICENSE09=DECproduct-name�Specifies up to ten license PAK names, as described in the License Product Name Definition� \Relate "client.doc!47", "License Product Name Definition" \D2HTargetDefault � section.  If more than one license is to be loaded, be sure to set the number of licenses accordingly, using the LICCOUNT parameter.��LICENSEGROUP=groupname�Specifies the license group name of the client. ��LICENSESERVER=server-name�Specifies the value of the server-name command line parameter for the PWLICLM command.  With LAN Manager, this value is the license server name associated with the address provided in LICENSEADDRESS.  ��LICENSEADDRESS=address�Specifies the DECnet or TCP/IP address of the license server named in LICENSESERVER  (LAN Manager only).

When LICENSESERVER and LICENSEADDRESS are both defined in the license configuration template file, the CLR will associate the license server name with the license_address as follows:

For DECnet-Plus clients:

NCP SET REMOTE-ADAPTER-NAME�PWRK$L{licenseserver} NODE�{license_address}

where license_address is the DIGITAL DECnet-Plus hardware address.

For DIGITAL TCP/IP stack clients:

INETNAME PWRK$L{licenseserver}�{license_address}

where TCP/IP is the TCP/IP address.�����LICHINT=n (for LAN Manager)

LICHINTNW=n (for NetWare)�Specifies the value associated with the default product license to request.

This value is used if values are not supplied for, LICENSE00 through LICENSE09, either in the PATHWORKS configuration template file or in the license configuration file.

The value of n may be one of the following:

(  0 for DECPWLMXXXFPnn.nn (LAN Manager) DECPWNWXXFPnn.nn (NetWare)

(  1 for DECPWLMDOSCCnn.nn (LAN Manager) DECPWNWDOSCCnn.nn (NetWare)

(  2 for DECPWXXXDOSATnn.nn��DECNETNODENAME=nodename�DECNETNODENUMBER=nodenumber�TCPIPNODENAME=IPnodename

For LAN Manager:�  USERNAME=username�  SERVERNAME=servername�  COMPUTERNAME=clientname

For NetWare:�  NWUSERNAME=username�  NWSERVERNAME=servername�These and the following values are provided to the license server and are used by the license management software to identify the owner of a license.��

Specifying Licensing Software Parameters on Windows for Workgroups Clients

� XE "Licensing software:parameters on Windows for Workgroups" �For Windows for Workgroups computers, the client license requester program is a LAN Manager protected-mode component (INSTLICL.DLL) that requests client-based licenses from the license server.

To request licenses over dialup lines, or using NetWare, run the Windows for Workgroups computer in real mode and use the following programs:

INSTLICL.EXE for LAN Manager

PWLICNW.EXE for NetWare

You manage the licensing software for NetWare clients in the same way you manage the licensing software for DOS and Windows clients.  Refer to the Specifying Licensing Software Parameters for DOS and Windows Clients� \Relate "client.doc!14", "Specifying Licensing Software Parameters for DOS and Windows Clients" \D2HTargetDefault � section in this guide for more information.

The licensing software parameters are specified in one of the following ways:

If the client computer is running PATHWORKS for DOS and Windows, you can specify the licensing software parameters in the PATHWORKS configuration template file.  Refer to the PATHWORKS Configuration Template File Parameters for Windows for Workgroups table (see Table 5-4) in this guide for more information.

Through the [DECLICL] section of the file \WINDOWS\SYSTEM.INI.  The licensing software parameters for Windows for Workgroups clients are described in the following table.

Table �styleref "BeginChapter"�5�–3   Licensing Parameters for Windows for Workgroups SYSTEM.INI File� XE "Licensing software:parameters for Windows for Workgroups" �

Windows for Workgroups Parameter�Description��LICENSE00=DECproduct-name�through�LICENSE09=DECproduct-name�Specifies up to ten license product names.  Refer to the License Product Name Definition� \Relate "client.doc!47", "License Product Name Definition" \D2HTargetDefault � section in this guide for information about specifying license product-names.��LICENSEGROUP=groupname�Specifies the license group name of the client. ��LICENSESERVER=servername�Specifies the license server name.

This parameter is required for clients requesting licenses over a wide area network (WAN) and in cases where the license server is on a local area network (LAN) outside the client’s local LAN.  The named server (servername) will be the first server asked for new licenses.��LICHINT=n�Specifies the default product PAK to request.

This value is used if no values are supplied for LICENSE00 through LICENSE09, either in the SYSTEM.INI file or the license configuration template file.

The value of n may be one of the following:

(  0 for DECPWLMXXXCAnn.nn

(  1 for DECPWLMDOSCCnn.nn

(  2 for DECPWXXXDOSATnn.nn��LICTIMEOUT=seconds�Maximum time (in seconds) to allow for connecting to each license server and getting a response for each license server request.  The default is 5 seconds.��

The PATHWORKS configuration template file parameters for Windows for Workgroups client computers running PATHWORKS for DOS and Windows are described in the following table:

Table �styleref "BeginChapter"�5�–4   PATHWORKS Configuration Template File Parameters for Windows for Workgroups� XE "PATHWORKS configuration:template file parameters for Windows for Workgroups" �

Parameter�Description��LICENSE00=DECproduct-name�through LICENSE09=DECproduct-name�Specifies up to ten license product names.  Refer to the License Product Name Definition� \Relate "client.doc!47", "License Product Name Definition" \D2HTargetDefault � section in this guide for information about specifying license product-names.��LICENSEGROUP=groupname�Specifies the license group name of the client. ��LICHINTNW=n�Specifies the value associated with the default product name to request, if values are not supplied for LICENSE00 through LICENSE09.

The value of n may be one of the following:

( 0 for DECPWLMXXXCAnn.nn

( 1 for DECPWLMDOSCCnn.nn

( 2 for DECPWXXXDOSATnn.nn��LICENSESERVER=server-name�Specifies the value of the server-name command line parameter for the PWLICLM command.  ��COMPUTERNAME=clientname�DECNETNODENAME=nodename�DECNETNODENUMBER=nodenumber�SERVERNAME=servername�TCPIPNODENAME=IPnodename�USERNAME=username�These values are provided to the license server and are used by the license management software to identify the owner of a license.��

Specifying Licensing Software Parameters on Windows 95 and Windows NT Computers

� XE "Licensing software:parameters on Windows 95" �� XE "Licensing software:parameters on Windows NT" �Under Windows 95 and Windows NT, the licensing software components are a protected-mode LAN Manager components:

The client license transponder (CLT) is PNLT32.EXE (LAN Manager), PILT32M.EXE (Microsoft NetWare), and PILT32N.EXE (Novell NetWare)

The client license requester (CLR) is PNLR32.EXE (LAN Manager), PILR32M.EXE (Microsoft NetWare), and PILR32N.EXE (Novell NetWare)

The CLR runs on any Windows 95 or Windows NT client computer and requests client-based licenses from the license server.  Depending on the networking software on the client computer, you can use the DEC LAN Manager Licensing Agent, as described in the DIGITAL PATHWORKS 32 User’s Guide.  To specify the licensing parameters, follow these steps:

Select Run from the Start menu.

Enter PNLCFG (for LAN Manager) or PILCFG (for NetWare).

The field names shown in the Licensing Software Properties dialog box are listed in the following table:

Table �styleref "BeginChapter"�5�–5   Licensing Software Properties� XE "Licensing software:properties on Windows 95 network control panel" �

Property Name�Description��Remote License Servers (for LAN Manager) or Preferred License Servers (for NetWare)�Specifies license server names.  This parameter is required for wide area network (WAN) configurations, where the license server is not in the same local area network (LAN) as the client computer.  The named license servers will also be the first servers from which licenses are requested.  For more information about configuring clients for wide area network access, refer to Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � in this guide.��License Group�Specifies the client’s license group.  Only licenses assigned to the named group will be used.  If not specified, new licenses are requested from the group named “Default.”��Select Licenses�Specifies the license PAK names of licenses to be requested, as described in the License Product Name Definition� \Relate "client.doc!47", "License Product Name Definition" \D2HTargetDefault � section in this guide.

For example, enter:

DEC-PWXXDOSAT06.00�DEC-PWLMXXXFP05.00��Timeout�Specifies the maximum time (in seconds) to allow for connecting for each license server request.  The default timeout value is 5 seconds.  When operations fail due to a timeout condition, an error message is logged.��

� XE "Dial-up connection" �To obtain a license over a dial-up connection (LAN Manager only), start the licensing software using the Run selection on the Start menu.  Enter the following:

PNLR32

Enabling WAN Operations

� XE "WANs:enabling operations" �� XE "Enabling:WAN operations" �Client computers outside of the local area network where the license server is running can request a license from the license server in one of the following ways:

If the local server is acting as a WINS client, the WINS server resolves the license server name.  Refer to the Configuration Manager topic in the DIGITAL PATHWORKS for OpenVMS (Advanced Server) Server Administrator’s Guide, for more information about how to set up the server as a WINS client.  This configuration is supported in Microsoft TCP/IP network environments on Windows 95 and Windows NT.

If the client is using Microsoft TCP/IP, it may have an LMHOST file to map the NETBIOS name to the TCP/IP address, as described below.

Obtaining Client-Based Licenses Over WANs

� XE "Obtaining client-based licenses over WANs" �This section provides information you need to configure licensing software on client computers that are not in the same local area network with the license server, but must acquire client-based licenses.

When the license server that is to provide client-based licenses is not on the same LAN as the client system, additional setup is required at the client system.  The two required steps are:

Configure the WAN protocol stack (DECnet or TCP/IP) to map the license server's NetBIOS name (usually the node or host name with the prefix "PWRK$L") to the WAN address of the license server system.

Configure the licensing software components with the name of the license server.

Configuring the WAN Protocol Stack for WAN Licensing

� XE "Configuring:the WAN protocol stack" �In this step, you will give the WAN protocol stack the NetBIOS name of the license server and the WAN address of the license server system.  The WAN protocol stack configuration steps depend on which WAN protocol stack is being used.  The following sections describe the procedures for the commonly used WAN protocol stacks:

PATHWORKS DECnet

Microsoft TCP/IP

PATHWORKS TCP/IP

OS/2 TCP/IP

�Configuring PATHWORKS DECnet for WAN Licensing

At the command prompt, issue the following command:

NCP DEFINE REMOTE-ADAPTER-NAME PWRK$Lname NODE decnet-address

For example:

The license server system has a DECnet address of 12.345 and the license server name is "ZIPHED":

NCP DEFINE REMOTE-ADAPTER-NAME PWRK$LZIPHED NODE 12.345

Configuring Microsoft TCP/IP for WAN Licensing

Search for the file LMHOSTS.  If it does not exist, search for the file LMHOSTS.SAM and make a copy in the same directory with the name "LMHOSTS."

Edit LMHOSTS using whatever text editor you like and add the following line:

address PWRK$Lname

For example:

The license server system has a TCP/IP address of 12.34.56.78 and the license server name is "ZIPHED":

12.34.56.78 PWRK$LZIPHED

Configuring PATHWORKS TCP/IP for WAN Licensing

At the command prompt, issue the following command:

INETNAME PWRK$Lname address

For example:

The license server system has an IP address of 12.34.56.78 and the license server name is "ZIPHED":

INETNAME PWRK$LZIPHED 12.34.56.78

Configuring OS/2 TCP/IP for WAN Licensing

Edit \IBMCOM\RFCNAMES.LST using whatever text editor you like and add the following line:

"PWRK$Lname" address

For example:

The license server system has an IP address of 12.34.56.78 and the license server name is "ZIPHED":

"PWRK$LZIPPHED" 12.34.56.78

Configuring the License Server Name

� XE "Configuring:the license server name" �Once the WAN protocol stack has been configured to map the NetBIOS name of the license server to the WAN address of the license server system, configure the licensing software with the NetBIOS name of the license server.  The method to use depends on the client platform.

Configuring the License Server Name for DOS, Windows 3.1, or OS/2

Use the NetBIOS name of the license server on the PWLICLM.EXE command line.  For example, if the license server name is "ZIPHED," run PWLICLM.EXE as follows:

PWLICLM PWRK$LZIPHED

Configuring the License Server Name for Windows for Workgroups

Edit the SYSTEM.INI file and add the following line to the [DECLICL] section:

LICENSESERVER=PWRK$Lname

For example, if the license server name is "ZIPHED" use the following:

LICENSESERVER=PWRK$LZIPHED

Configuring the License Server Name for Windows 95, or Windows NT

Run the program PNLCFG.EXE and add the license server to the list of "Remote License Servers" in the dialog box.

��� INCLUDETEXT d:\\license\\cmess.doc \* MERGEFORMAT �� Seq D2HDocument \h \r9 �� seq Chapters \r � seq Appendix \r1 �1� \* Alphabetic �A�

Client Messages

Introduction

�xe "Client licensing messages"��xe "Licensing messages:client "��xe "Messages"��xe "Messages:client "��xe "Error messages:client "�This section explains client licensing messages and describes corrective actions where appropriate and includes the following topics:

Message That Results from Accessing the Server Without a License� \Relate "cmess.doc!40", "Message That Results from Accessing the Server Without a License" \D2HTargetDefault � ( describes the system error message you receive when you attempt to access the file server without a license.

Messages That Result from Running the License Programs� \Relate "cmess.doc!41", "Messages That Result from Running the License Programs" \D2HTargetDefault � ( describes the messages you receive when you run the Client Transponder or Client Requester programs.

Note:  Italicized variables in the message text, such as n or group-name, have real values inserted when you receive an actual message.

In many of the messages, the user action involves running the Client Transponder or Client Requester programs. 

If your client cannot obtain a client-based license, one of the following reasons may apply:

The license server is not configured or running.

PATHWORKS is not started.

PATHWORKS is not configured or is incorrectly configured for the transport being used by the client.

Required PAKs are not loaded and registered.

There are no available licenses in the PATHWORKS server.

To prepare the license server:

Ensure that it is running and properly configured and that the client-based PAKs are registered and loaded in the LMF on the same system. 

Ensure that licenses are available in the License Manager by reallocating or adding new ones.  

Use the License Manager to check all occurrences of the server.  These occurrences need a preceding qualifier: license server or file server, or file server and print server. 

After preparing the license server, run the Client Requester program again.



Message That Results from Accessing the Server Without a License

�xe "Intruder detection lockout"�If you access a file server without a license, you may be denied access or receive restricted access.  You may receive the following message: 

System Error 71:  The network request was not accepted; or DOS error 58 has occurred.

For Windows NT, you may receive the following message: 

System Error 71:  No more connections can be made to this remote computer at this time because there are already as many connections as the computer can accept.

Explanation 

If you have your LAN Manager client messenger (Alerter) service loaded, you may receive the following message: 

Connection attempt denied;�server failed to authenticate a license for�client 

Additionally, log entries in the PATHWORKS Version 5 event logger or Windows NT registry might reflect the denial or restriction of access to the server based on license authorization.  See the Appendix B, Server Messages, the PATHWORKS Event Logger Errors� \Relate "smess.doc!18", "PATHWORKS Event Logger Errors" \D2HTargetDefault � section, in this guide for further details. 

If you are denied access to a server:

Verify that you have a client-based license, by executing the Client Requester program with a /SHOW switch, or ensure that you have sufficient server-based license capacity. 

If you do not have a client-based license, run the Client Requester program to acquire one, or register and load additional server-based license PAKs on your server system.

Messages That Result from Running the License Programs

The following messages may be displayed on the client screen when you run the Client Transponder or Client Requester programs.  If you get any of these messages, you may not have a license. 

LIC0001: Unrecognized argument argument-passed.

Explanation:  The command line contains one or more arguments that are misspelled or incorrectly formatted.

User Action:  Check the command line arguments.  

LIC0002: Incompatible license versions.

Explanation:  Unexpected error from the Client Transponder program.

User Action:  Update the Client Transponder program.

LIC0003: WARNING:  The environment variable PCSA is not defined, but the PATHWORKS network scheduler (SCH) has been loaded.  

Explanation:  Every PATHWORKS for DOS and Windows client should have the PCSA environment variable set to point to the directory where PATHWORKS is installed.  The current client has the PATHWORKS network scheduler loaded, but does not have the PCSA environment variable set, so it appears to be an incorrectly configured PATHWORKS client.

User Action:  Re-install PATHWORKS on the client.

LIC0004: Not enough memory available for Client Transponder.

Explanation:  The Client Transponder program was unable to allocate memory for its internal buffers.

User Action:  Unload any terminate-and-stay-resident applications (TSRs) already loaded and run the Client Transponder program again.

LIC0007: Unable to release excess memory.

Explanation:  The Client Requester program or Client Transponder program could not release memory that is not needed by the Client Transponder program.

User Action:  Try running the Client Requester program from the DOS prompt.  If memory management software is installed, try removing it and run the program again.  Remove any TSRs from memory that can prevent DOS from freeing up memory.

LIC0008: Network software not loaded or problem configuring network.

Explanation:  The network is not running.

User Action:  Be sure the network starts correctly before running the Client Transponder or Client Requester programs.  If the problem persists, re-install your network software.

LIC0009: All network sockets are currently in use.

Explanation:  The Client Requester program could not establish a connection with a license server because all network sessions are in use.

User Action:  Configure the network software to allow more NetBIOS (LAN Manager) or IPX (NetWare) sessions.

LIC0010: License transponder already resident in memory.

Explanation:  An attempt was made to load the Client Transponder program, but it is already resident.

User Action:  None required. 

LIC0010 (OS/2 Only):  Unrecognized argument argument-passed.

Explanation:  The user passed an illegal parameter.

User Action:  Restart the program, correcting the illegal parameter. 

LIC0011:  PATHWORKS  transport client Client Transponder for platform (filename), is not in memory.

Explanation:  The Client Requester program was unable to contact the Client Transponder program.

User Action:  Re-install PATHWORKS on the client.

LIC0012: Unable to read license information in file drive:filename.

Explanation:  A read error occurred while reading the specified file. The Client Requester program will scan the network to recreate the license information.

User Action:  None required. 

LIC0013: No License servers are available to satisfy request.

Explanation:  The Client Requester program could not contact any license servers.

User Action:  If there is a license server on the same LAN as the client then there may be a problem in the network between the two, or they may not share a network protocol. If the license server is not on the same LAN as the client, such as when the client is a dial-up client or at a branch office, be sure to specify the name of the license server in the Client Requester program setup information.  See Chapter 5, Configuring Client Software, the Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � section in this guide, for WAN setup.

LIC0013 (OS/2 Only): Invalid time-out value specified time-out.

Explanation:  The Client Requester program time-out command line parameter exceeds the value allowed.

User Action:  Restart the program, correcting the illegal parameter. 

LIC0014: Invalid time-out value specified n.

Explanation:  The timeout value entered on the Client Requester program command line is not number or is less than 1.

User Action:  Use a numeric value of 1 or greater. 

LIC0014 (OS/2 Only): Path location already specified.

Explanation:  You specified the /License:licfile.txt switch more than once on the Client Requester program command line.

User Action:  Enter the command again specifying the switch only once. 

LIC0015: WARNING: The environment variable PWTPL is not defined.  Since the PATHWORKS template file cannot be found, the required licenses type will default to "Combined Client and Server" (CCS) and some information about this PATHWORKS client may be incorrect.

Explanation:  On a PATHWORKS for DOS and Windows client the PWTPL environment variable should point to the PATHWORKS template.  The system appears to be a PATHWORKS client, but the PWTPL environment variable is not set.

User Action:  Re-install PATHWORKS on the client.

LIC0015 (OS/2 Only): Invalid path specified path. (Maximum length is n characters.) 

Explanation:  The path name length plus the file name exceeds the allowed limit.

User Action:  Enter the command again using a shorter path. 

LIC0016: Unable to open PATHWORKS template file file.

Explanation:  The PWTPL environment variable is set, but the file it points to does not exist.

User Action:  Re-install PATHWORKS on the client.

�LIC0016 (OS/2 Only): Invalid license server specified server.  (Maximum length is n characters.) 

Explanation:  The license server node name exceeds the limit. The Client Requester program will only accept node name lengths to n characters.  The actual maximum node name length depends on the network transport in use.

User Action:  Enter the proper node name on which the license server is executing. 

LIC0017: Network name not set.

Explanation:  The LAN Manager Client Requester  and Client Transponder programs must have the NetBIOS name set before execution.

User Action:   Re-install the network on the client.

LIC0017 (OS/2 Only): Invalid group specified group. (Maximum length is n characters.) 

Explanation:  The group name specified exceeds the allowed limit.

User Action:  Enter the command again using a shorter group name. 

LIC0018: Invalid path specified path.  (Maximum length is 244 characters.)

Explanation:  The /NEEDED: (or /FILE:) command line switches either include no value or a value that exceeds the DOS limit.

User Action:  Use a valid path.

LIC0019: Invalid license server specified server.  (Maximum length is 47 characters.)

Explanation:  The license server node name cannot be longer than 47 characters.

User Action:  Enter a valid license server name.  Usually this is the node name (or cluster alias) of the system running the license server.

LIC0020: Invalid group specified group.  (Maximum length is 20 characters.)

Explanation:  The group specified on the command line is illegal; the length cannot exceed 20 characters.

User Action:  Use a legal license group name. 

LIC0021:  License server could not provide a license of type license type, assigned to license group groupname.

Explanation:  The license server specified in the setup information was unable to supply one or more of the licenses needed.

User Action:  Check the server name, license type and license group for typographical errors.  If the data is correct, check that all required WAN setup has been done.  Check that the specified server has licenses of the needed type and group available.

LIC0022: Could not add license name to local tables.

Explanation:  The local NetBIOS name table is full.

User Action:  Increase the size of the local name table and restart the network. 

LIC0022 (OS/2 Only): Could not add license name to local tables.

Explanation:  The local NetBIOS name table is full.

User Action:  Increase the size of the local name table and restart the network. 

LIC0023: Could not retrieve station address.

Explanation:  The program could not retrieve the station address from the NetBIOS interface.

User Action:  Ensure the network has started properly. 

LIC0023 (OS/2 Only): Could not retrieve station address.

Explanation:  The program could not retrieve the station address from the NetBIOS interface.

User Action:  Ensure the network has started properly. 

LIC0024: Could not post receive buffer.

Explanation:  The license program tried to post an asynchronous receive buffer and failed.

User Action:  Increase the number of Network Control Blocks (NCBs) allowed. 

LIC0024 (OS/2 Only): Could not post receive buffer.

Explanation:  The Client Requester program tried to post an asynchronous receive buffer and failed.

User Action:  Increase the number of NCBs allowed. 

LIC0025: Unexpected status code 0xhh from transponder.

Explanation:  The Client Transponder program returned a value that is not a known status code.

User Action:   Check the version of the Client Transponder program.

LIC0025 (OS/2 Only): Could not post listen.

Explanation:  The license program tried to post an asynchronous listen and failed.

User Action:  Increase the number of simultaneous commands allowed. 

LIC0026: License transponder is not loaded.

Explanation:  The Client Transponder program is not loaded.  It must be loaded before the Client Requester program is loaded.

User Action:  Run the Client Transponder program, then run the Client Requester program again.  

LIC0026 (OS/2 Only): Could not connect to license server node.

Explanation:  The program tried to connect to a license server on the specified node and failed.

User Action:  Ensure that the license server is running on that node.  For WAN connections, ensure that the remote name is defined to the client. 

LIC0027: Warning: could not post listen.

Explanation:  The license program tried to post an asynchronous listen and failed.

User Action:  None.  To make this warning less likely to occur, increase the number of simultaneous commands allowed.

LIC0027 (OS/2 Only): Could not shut down NetBIOS session.

Explanation:  The program tried to shut down a communication session with a license server that may already have been closed.

User Action:  None required. 

LIC0028: Could not connect to license server node-name.

Explanation:  The program tried to connect to a license server on the specified node and failed.

User Action:  Check to make sure that the license server is running on that node.  For WAN connections, see Chapter 5, Configuring Client Software, the Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � section in this guide.

LIC0028 (OS/2 Only): Could not send request to server node.

Explanation:  The program tried to send a request to the server and failed.  This could be due to a session disconnect between the Client Requester program and the license server.

User Action:  If no license was obtained, run the Client Requester program again.  If the problem persists, notify your system or network administrator. 

�LIC0029: Could not shut down NetBIOS session.

Explanation:  The program tried to shut down a communication session with a license server that may already have been closed.

User Action:  None required. 

LIC0029 (OS/2 Only):  Could not post any listen commands.

Explanation:  The license program tried to post a number of asynchronous listen commands and failed.

User Action:  Increase the number of simultaneous commands allowed. 

LIC0030: Could not send request to server node-name.

Explanation:  The program tried to send a request to the server and failed.  This could be due to a session disconnect between the Client Requester program and the license server.

User Action:  If no license was obtained, run the Client Requester program again.  If the problem persists, notify your system or network administrator.

LIC0031: Could not post any listen commands.

Explanation:  The license program tried to post a number of asynchronous listen commands and failed.

User Action:  The program exited because it could not post any listen commands.  To make this less likely to occur, increase the number of simultaneous commands allowed.

LIC0032:  Incompatible license records.

Explanation:  The Client Requester program could not load the license information into the Client Transponder program because the license records are incompatible.

User Action:  Run compatible versions of the Client Requester and Client Transponder programs. 

LIC0032 (OS/2 Only):  Unable to communicate over network, increase number of simultaneous commands and sessions allowed by the transport. 

Explanation:  The license program could not communicate over network. 

User Action: Increase the number of simultaneous commands and sessions allowed. 

LIC0033:  Not enough memory available for Client Transponder.

Explanation:  The Client Requester program could not load the license information into the Client Transponder program because there was not enough memory allocated by the Client Transponder program when it was loaded.

User Action:  Load the Client Transponder program using the /L: switch, increasing the number of license slots allocated by the program from the default of 1 to the number of licenses to be requested by the Client Requester program. 

LIC0034:  Warning:  The data file filename was created by a different version of the Client Requester program. Automatic update done.

Explanation:  The record format of the PWLICxx.DAT file was changed after PATHWORKS Version 5.1 for DOS and Windows.  The old file cannot be used by the new Client Requester program, but the data will be recovered from the license servers on the network and the data file will be updated automatically.

User Action:  No action required

LIC0035: Unable to write license information to file path.  Unable to write license information to file path.  The list of current licenses could not be saved.  This will mean a slightly greater delay the next time you run the PATHWORKS Client Requester program.  Before then, please make sure the disk is write enabled and has at least count free bytes of disk space.

Explanation:  The license data file could not be created or could not be written. 

User Action:  Make sure that the disk is write enabled and contains at least count free bytes of disk space, and then run the Client Requester program again. 

LIC0036: Not enough memory available to run program.

Explanation:  The Client Requester program requires about 100Kb memory.

User Action:  Make sure that enough memory is available to run the program. 

LIC0037: License server returned invalid license.

Explanation:  The license returned from the license server is not the one requested.  The Client Requester program tries to release the invalid license.

User Action:  At this point the client is unlicensed.  Check to make sure that you have a license by running the Client Requester program with the /SHOW switch.  This lists the licenses that the client has obtained from the license server. You may have to execute the Client Requester program again to obtain a license. 

LIC0037 (OS/2 Only):  Incompatible license records.

Explanation:  The Client Requester program could not load the license information into the Client Transponder program because the license records are incompatible.

User Action:  Run compatible versions of the Client Requester program and the Client Transponder program. 

�LIC0038:  Unable to open user-supplied license file file-name.

Explanation:  The license override file supplied on the command line could not be opened.

User Action:  Make sure that the path supplied is correct or that the license file is in the DOS PATH. 

LIC0038 (OS/2 Only):  Not enough memory available for Client Transponder program.

Explanation:  The Client Requester program could not load the license information into the Client Transponder program because there was not enough license records allocated by the Client Transponder program when it was loaded.

User Action:  Increase the maximum number of license records allocated for the Client Transponder program using the maximum licenses entry in the License Dialog screen, under the Configuration menu of the PATHWORKS Configuration Utility.  This parameter will take effect the next time the client is rebooted. 

LIC0039: WARNING DECnet Wide Area Network not supported with this configuration. Check if node is defined in the DECnet database.

Explanation:  The Client Requester program tried to add the remote adapter name of the license server to the DECnet network database.

User Action:  None, if the license server is not on the same LAN as the client.

If the license server is not on the same LAN as the client, make sure that the node name of the license server is defined in the DECnet network database.  

LIC0040: Unable to communicate over network, increase number of simultaneous commands allowed by transport and number of sessions allowed by transport.

Explanation:  The license program could not communicate over the network.

User Action:  The program exited because it could not post any listen commands.  To make this less likely to occur, increase the number of simultaneous commands allowed.  

LIC0041: Unable to obtain a license for product_name.

Explanation:  The Client Requester program could not obtain a license for product_name.  Possible reasons for this are:

The license server is beyond a router (is outside the LAN) and the WAN has not been set up.

No license server on the LAN has the specific license being requested, possibly due to a typographical error in the requested license type or license group name. 

The specified license group either does not exist or has not been assigned any licenses of the specified type. 

A license server with the correct licenses installed exists, but is unable to communicate over the network.

User Action:  

For license servers outside the LAN, see Chapter 5, Configuring Client Software, the Enabling WAN Operations� \Relate "client.doc!15", "Enabling WAN Operations" \D2HTargetDefault � section in this guide, for WAN setup instructions.

If the license is being requested by name, check that the first three letters match the Producer code of the Product Authorization Key (PAK) and that the remaining letters match the Product code of the PAK. 

Check the spelling of the license group name against the spelling at the license server.  Check that licenses of the requested type are assigned to the group. 

Check that the license server and the client share a network transport protocol (NetBEUI, DECnet, TCP/IP, or IPX).  It may help to restart the license server. 

LIC0042: Path location already specified.

Explanation:  You specified the /I:path switch more than once on the Client Requester program command line.  

User Action:  Enter the command again, specifying the switch only once. 

LIC0042 (OS/2 Only):  Network software not loaded.

Explanation:  The client network software is not loaded or configured correctly.

User Action:  Load or properly configure the client network software before executing the client license programs. 

LIC0043 License server is not available.

Explanation:  A license server name was specified, but that license server is not reachable.

User Action:  Check the spelling of the license server name.  If any other error occurred, check user actions for those messages.  It may help to restart the license server. 

LIC0044: Unable to obtain a license for product_name.

Explanation:  See message LIC0041.  

User Action:   See message LIC0041.

�LIC0044 (OS/2 Only):  License transponder already resident in memory.

Explanation:  An attempt was made to load the Client Transponder program, but it is already resident.

User Action:  None required. 

LIC0045:  NetBIOS Name Claim failed on LANA n; The name name is already in the local name table.  Probably an earlier use of the Client Requester program did not complete correctly.  Restart the system at your earliest convenience.

Explanation:  The Client Requester program needs a unique network name for use on the network.  The name it uses is the client's node name with an "L" in place of the last character. This name was already in use by another program.  Usually this means that the Client Requester program failed to release the name the last time it was run.

User Action:  Restart the client to try again with an empty name table.

LIC0045 (OS/2 Only): License transponder not resident in memory.

Explanation:  The Client Transponder program is not loaded.  It must be loaded before the Client Requester program is run.

User Action:  Detach the Client Transponder program using the command line, then run the Client Requester program again. 

LIC0046:  NetBIOS Name Claim failed on LANA n; the local name table is full.  Configure to allow more names.

Explanation:  The Client Requester program needs a unique network name for use on the network.  The name table for one of the network protocol stacks was already full so the new name could not be assigned.

User Action:  Configure the network protocol stack using LANA n to allow  for more names in its table.

LIC0047:  NetBIOS Name Claim failed on LANA n; Your name name is being used by another node!

Explanation: The Client Requester program needs a unique network name for use on the network.  The name it uses is the client's node name with an "L" in place of the last character. This name was already in use by another system.  Usually this means that your NetBIOS name is not unique on the network.

User Action: Re-install the network using a unique name.

LIC0048:  NetBIOS Name Claim failed on LANA n; Network interface is too busy to handle the request.

Explanation:  General network error.

User Action:  Restart the system.

LIC0049: NetBIOS Name Claim failed on LANA n; Too many pending commands.  Try to configure to allow more.

Explanation:  The network protocol stack on LANA n has run out of table space it uses to keep track of pending operations.

User Action:  Configure the network protocol stack for a larger table size.

LIC0049 (OS/2 Only): Unable to read license information in profile.

Explanation:  The specified file does not contain valid license information.  The file may be corrupted.  The Client Requester program scans the network to recover the lost license information.  If the license cannot be recovered, a new one will be requested.

User Action:  None required. 

LIC 0050: NetBIOS Name Claim failed on LANA n; Unexpected NetBIOS return code 0xhh.

Explanation:  The Client Requester program needs a unique network name for use on the network.  The network protocol stack on LANA n could not assign the name for some unknown reason.

User Action: Re-start the system.  If the problem persists, reinstall the network protocol stack.

LIC0050 (OS/2 Only):  Decryption of file failed.

Explanation:  The license information file was corrupted and is no longer readable by the Client Requester program.  The Client Requester program scans the network to recover the lost license information.  If the Client Requester program does not recover the information, it requests a new license.

User Action:  None required. 

LIC0051 (OS/2 Only):  Unable to open user-supplied license file file.

Explanation:  The license override file supplied on the command line could not be opened.

User Action:  Make sure that the path supplied is correct or that the license file is in the DPATH. 

LIC0052 (OS/2 Only):  Unable to write license information to profile.

Explanation:  License information was not saved.

User Action:  Ensure that the disk is not full. 

LIC0053 (OS/2 Only):  Not enough memory available to run program.

Explanation:  The Client Requester program could not allocate memory for the license database.

User Action:  Increase memory available to the program. 

LIC0055: Warning: The following license servers failed to provide service:�	name (Timeout error)�	name (Name is unknown)�	name (Failed to respond)

For the connections that failed due to timeout, it may help to increase the timeout value.  The current timeout value is n seconds.

Explanation:  The named license servers advertised their services on the LAN, but did not respond when asked for services.

Timeout error:  An attempt to contact the server did not complete before time ran out.

Name is unknown:  The name provided by the license server when it advertised its services starts with an "*" or a null.

Failed to respond:  All attempts to contact the server have failed.

User Action:  For timeout errors it may be appropriate to increase the timeout period using the method described in the message.  For other errors or if the timeout period is already greater than 30 seconds, it may help to restart the named servers.

LIC0057: A NetBIOS CANCEL command failed to cancel a CALL command.  Contact the vendor of the network protocol stack on LANA n to see if a fix for this problem is available.

Explanation:  To provide the fastest possible service, connections to the license server are tried on all network transports at the same time and the first transport to successfully connect is used.  The connection attempts on the other transports, if any, are not needed and are canceled.  Some network protocol stacks have an error in the way they handle this cancel operation, which causes the cancel to fail (the connection attempt continues).  When this happens, the Client Requester program has to wait for those connection attempts to complete.  This adds delays to the operation of the Client Requester program.

User Action:  This is a problem in the network protocol stack.  Check with the vendor of the network protocol stack associated with the LANA number shown to see if they have a newer version of the network protocol stack which fixes this problem.

�LIC0058:  Warning:  license server name failed to respond to a request within the n seconds provided.

Explanation:  This is a problem in the network protocol stack.  Check with the vendor of the network protocol stack associated with the LANA number shown to see if they have a newer version of the network protocol stack that fixes this problem.

User Action: It may be appropriate to increase the timeout period.  If the timeout period is already greater than 30 seconds, it may help to restart the named license server.

LIC0060:  Warning:  The license server name is not available to validate the license it assigned you for product.  The license was last validated n days ago date and is still valid.

Explanation:  One of your licenses has not been validated for over a week.  It may be that the license server that provided your license has changed names or has been removed from the network.

User Action:  If the license server is supposed to still be in service, it may be appropriate to restart the license server.  If the license server has been renamed or removed, delete the PWLICLM.DAT (LAN Manager) or PWLICNW.DAT (NetWare) license data file and restart the client.  This should allow you to acquire a license from a working license server.

LIC0061: License file %s read failed�LIC0062: License file %s ID not valid�LIC0063: License file %s version number not valid

Explanation:  The PWLICLM.DAT (LAN Manager) or PWLICNW.DAT (NetWare) license data file has bad data in it.  The data will be recovered from the license servers on the network and the file will be rewritten.

User Action:  No action required.

LIC0065: Failed to get a valid address for client, datalink error n

Explanation:  The Digital DataLink Layer returned an unexpected error code.

User Action:  Re-install the network device driver.

LIC0066: Only one license server name allowed on command line name.

Explanation:  Any text on the command line that does not start with a "/" character is considered to be a license server name.  Only one such name is allowed on the command line. 

User Action:  Check the command line and try again.

�LIC0067:  Command line switch actual is ambiguous.  Did you want possible?

Explanation:  Command line switches can be abbreviated, but enough letters must be provided so that only one possible switch will match.  The switch shown was too short and matches the start of two or more possible switches.  The message is repeated to show all the possible matches.

User Action:  Extend the abbreviation enough to uniquely specify the switch.

LIC0068: Command line switch switch overrides earlier switch switch.

Explanation:  Some command line switches cannot be used together: "/SHOW", "/PWACCESS", "/NOCONNECTION", and "/SERVERS".  The switches shown in the message were both specified on the command line and only the last one specified will take effect.

User Action:  Remove extra switches from the command line.

LIC0069: License server server sent a response with bad encryption

Explanation:  License requests and responses are encrypted when sent on the network.  A checksum is used to test data integrity.  The named server sent a response that, after decryption, failed the checksum test.  This usually means that the encryption key used by the license server did not match the decryption key used by the Client Requester.

User Action:  It may be appropriate to restart the license server.

LIC0069 (OS/2 Only):  No license servers are available to satisfy request.

Explanation:  The Client Requester program did not receive a response from querying the network for license servers.

User Action:  Ensure that a license server is running on the LAN, or specify a remote name for a license server running on a WAN. 

LIC0071:  The date of last validation on the license product is date, but the current date set on this system is date.  Check the date setting on this machine and on server.

Explanation:  Each time a license server validates a license, it provides the current date and time.  If the validation date of a license is more than one day ahead of the current date on the client, it means that one or both of the systems have their date set wrong.

User Action:  Check and correct the date on the client.  If the date on the client is already correct, have the system manager of the license server correct the date on that machine.

�LIC0073 (OS/2 Only):  Unable to obtain a license for product_name.

Explanation:  The Client Requester program could not obtain a license for product_name.

User Action:  Ensure that you have sufficient licenses loaded.  

LIC0084 (OS/2 Only): license server returned invalid license.

Explanation:  The license returned from the license server is not acceptable.  The Client Requester program tries to release the invalid license.

User Action:  The client is unlicensed.  Ensure that you have a license by running the Client Requester program with the /SHOW switch.  This reports the licenses that the client has obtained from the license server.

LIC0090:  DECCORE.VXD is not responding

Explanation:  The DIGITAL protected-mode driver is not installed.  The protected-mode version of the Client Requester program needs the services provided by DECCORE.VXD and cannot run without it.

User Action:   Re-install the Client Requester program.  If that fails, re-install PATHWORKS.

LIC0091:  Could not start Protected Mode Licensing.  This version of licensing must be used with Windows for Workgroups or Windows 95.  Use Real Mode Licensing for DOS and Windows 3.x.

Explanation:  The protected-mode version of the Client Requester program (INSTLICL.DLL) will only work with a protected-mode network.  You cannot use INSTLICL.DLL with Windows 3.1 or with Windows for Workgroups and a Basic Redirector.

User Action:  Re-install PATHWORKS.

LIC0092:  VNetBIOS is not responding

Explanation:  The protected-mode version of the Client Requester program (INSTLICL.DLL) requires the protected-mode NetBIOS driver, VNetBIOS.

User Action:  Re-install the network.

LIC0093:  DECLICL.VXD is not responding

Explanation:  Re-install the network.

User Action:  Always load the Client Transponder program before the Client Requester program.  WFW:  Re-configure PATHWORKS.  Windows 95:  Remove and reinstall the network service "PATHWORKS Licensing Agent."

License for product_name is in use by another client.

Explanation:  The license is being used by another client.  A client license may be used by only one client at a time.  The license has been deleted from this client.

User Action:  Run the Client Requester program again to obtain a new license if one is needed.

License for product_name is not valid.

Explanation:  The license previously obtained by the Client Requester program has been invalidated by the license server.

User Action:  Check with your system administrator to determine the reason that your license has been invalidated.  You may run the Client Requester program on the client again to obtain a new license if necessary.  Note that the Client Requester program does not try to obtain a new license automatically when a license is invalidated. 

License for product_name successfully verified.

Explanation:  The Client Requester program successfully verified the license.

User Action:  None required.  

License server server-name is not available to satisfy request.

Explanation:  The Client Requester program could not establish a session with the license server specified.

User Action:  Make sure that the license server is running on that node and that it is running the same transports as the client.  

License successfully obtained.

Explanation:  The Client Requester program successfully obtained a license.

User Action:  None required. 

Scanning network...

Explanation:  The Client Requester program queries all license servers on the LAN to determine if the client has already been allocated a license from the license server.

User Action:  None required.

Searching for license servers...

Explanation:  The Client Requester program must search the LAN for a license server.  To shorten this process, you may enter the name of the license server on the command line.  

User Action:  None required.  

Time-out value set to n seconds.

Explanation:  The time-out default was overridden by a value entered on the command line.  

User Action:  None required.

Unable to verify license for product_name.

Explanation:  The Client Requester program failed to verify the license.  This may be caused by several reasons:

�SYMBOL 183 \f "Symbol" \s 10 \h�	The license server is not running.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The license server is not using the same transport.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Network problems may inhibit communications.

User Action:  The license on the client is assumed to be valid and is loaded in the Client Transponder program.  The client should determine if the license server is running and using the same transport, or if a network problem is inhibiting communication. 

Verifying license.

Explanation:  If the Client Requester program detected a previous license stored on the client, it tries to verify the license with the license server from which it was obtained.

User Action:  None required.
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Server Messages 

Introduction

�xe "Server licensing messages"��xe "Licensing messages:server "��xe "License Manager:messages "��xe "Messages"��xe "Messages:server "��xe "Error messages"��xe "Error messages:server "�This section explains the event messages that are logged to the license server and License Registrar log files as well as the PATHWORKS Event Logger.  It provides the license server messages, an explanation of these messages, and corrective action if appropriate and includes the following topics:

PATHWORKS for OpenVMS License Component Log Files� \Relate "smess.doc!42", "PATHWORKS for OpenVMS License Component Log Files" \D2HTargetDefault � ( describes the types of log files.

License Server Events� \Relate "smess.doc!45", "License Server Events" \D2HTargetDefault � ( describes events logged to the OpenVMS license server log file.

License Registrar Events� \Relate "smess.doc!17", "License Registrar Events" \D2HTargetDefault � ( describes events logged to the License Registrar log file.

PATHWORKS Event Logger Errors� \Relate "smess.doc!18", "PATHWORKS Event Logger Errors" \D2HTargetDefault � ( describes how to check the events logged to the Event Logger during PATHWORKS operations.

PATHWORKS for OpenVMS License Component Log Files

Log files are stored in a directory defined by the PWRK$LOGS logical name.  The two types of log files are:

License processing-related log files

License component program log files

License Processing-Related Log Files

� XE "Licenses:process-related log files" �� XE "Log files:process-related log files" �The names of the license processing-related log files are as follows:

License server log file:

PWRK$Logs:PWRK$LICENSE_SERVER_name1.LOG

where name1 is either the OpenVMS cluster alias name or the name of the node on which the license server is running.  

In most cases, name1 is also used to form the license server name on the local system:

PWRK$Lname2

where name2 is the same as name1.  

License Registrar log file(s): 

PWRK$Logs:PWRK$LICENSE_REGISTRAR_name.LOG

The name is the system name.

License Component Program Log Files

� XE "Licenses:component program log files" �� XE "Log files:component program log files" �The names of the license component program log files are as follows:

License server process:

PWRK$Logs:PWRK$LICENSE_S_name1.LOG

where name1 is either the OpenVMS cluster alias name or the name of the node on which the license server is running.  

In most cases, name1 is also used to form the license server name on the local system:

PWRK$Lname2

where name2 is the same as name1.  

License Registrar process:

PWRK$Logs:PWRK$LICENSE_R_name.LOG 

The name is the system name. 

License Server Events

This section describes events logged to the OpenVMS license server log file (PWRKS$LOGS:PWRK$LICENSE_SERVER_name.LOG).  Note that all the messages posted to the log file begin with a date/timestamp.

ALERT_LEVEL_REACHED:

Product = product-name �Group = group-name �Alert Level = alert-level-number �Allocation = number-of-licenses-allocated

Explanation:  The number of licenses currently in use for this product exceeds the alert level.  If the group-name is <NONE>, the alert level for all the product's licenses has been exceeded.  Otherwise, the alert level for the licenses in the specific group has been exceeded.

User Action:  Review the current license distribution.  Remove licenses from clients that no longer use the product, redistribute the available product licenses, or add new product licenses.  

CLIENT_ADDRESS_CHANGE: 

Client Id = client-id number �Old Client Addr = old-address�New Client Addr = new-address

Explanation:  The current client’s address is different from when the license was assigned.  Typically, this message indicates a license has been moved from one client to another.  

User Action:  Make sure that the change of client ID is valid.  

CLIENT_ID_CHANGE: 

Client Id = client-Id number �Old Client ID = old-id �New Client ID = new-id �Old Client Addr = old-address �New Client Addr = new-address

Explanation:  The current ID of the client is different from the ID it had when the license was assigned.  The client ID is the address of the Ethernet adapter.  Typically, this message indicates that a license has been reassigned from one client to another.  

User Action:  Make sure that the Ethernet address change is valid.  

CLIENT_LICENSE_ASSIGNED: 

Client ID = client-id number �Client Addr = client-address �Transport = transport-name �Product = product-name �Group = group-name

Explanation:  A product license was granted to the client from the group specified.

User Action:  None required.  

�CLIENT_LICENSE_DENIED: 

Client ID = client-id number �Client Addr = client-address �Transport = transport-name �Product = product-name �Group = group-name �Reason = explanation-string

Explanation:  The client's request for assignment of a license could not be processed as requested.

User Action:  If the reason is an incorrect product or group, check to be sure the license type exists and reconfigure the client to obtain a valid license.  If there are not enough licenses, the administrator must add, reallocate, or remove licenses to create available ones.  

CLIENT_LICENSE_INVALID: 

Client ID = client-id number�Client Addr = client-address �Transport = transport-name �Product = product-name �Group = group-name �Reason = explanation-string

Explanation:  The license presented for verification to the license server by the client is no longer valid.  

User Action:  If the reason is an incorrect product, group, or license, the data on the client may no longer be valid (for example, the group may have been deleted) and the license may have been revoked.  Reboot the client to obtain a valid license.  If the license is in use by another client, this may be a case of illegal copying of license data between clients and should be investigated.  

CLIENT_LICENSE_RELEASED: 

Client ID = client-id number�Client Addr = client-address �Product = product-name �Group = group-name

Explanation:  The system manager released the product license from the specified group.  

User Action:  None required.  

�CLIENT_LICENSE_REVOKED: 

Client ID = client-id number �Client Addr = client-address �Product = product-name �Group = group-name �Reason = explanation-string

Explanation:  The product license from the specified group was revoked or removed.  The reason string indicates whether it was due to an action taken by the License Manager, or due to changes in the OpenVMS License Management Facility (LMF) database.  This action can explain why a client's license is considered invalid in a later log event.

User Action:  You may have to add, reallocate, or remove currently allocated licenses to allow this client to use the file server in the future.

CLIENT_LICENSE_UPGRADE_ON_ASSIGN:

Client Id = client-id-number�Client Addr = client-address�Transport = transport-name�Group = group-name�V5 Product = version-5-product-name, for example PWLMDOSCC06.00�Product = product-name, for example, PWLMXXXCA06.00

Explanation:  The client requested a PWLMDOSCC06.00 license and the license server has defined the logical so the license server upgraded and assigned the PWLMXXXCA06.00 license.  The license returned to the client will be a virtual license (see the description under Explanation for message, VIRTUAL_CLIENT_LICENSE_RETURNED_ON_ASSIGN) 

User Action:  None required.

CLIENT_LICENSE_VALID: 

Client ID = client-id number �Client Addr = client-address �Transport = transport-name �Product = product-name �Group = group-name �Reason = explanation-string

Explanation:  The license presented for verification to the license server by the client is valid.

User Action:  None required.

�CLIENT_NOT_LICENSED: 

Client ID = client-id number �Client Addr = client-address �Transport = transport-name �Reason = explanation-string

Explanation:  The client is not licensed to access the file server.  The client does not have a client-based license that grants it the right to access the services provided by the file server and there are no server-based licenses available for the License Registrar to assign to the client to give the client access rights to the file server.

User Action:  Either configure the client to acquire a client-based license to access the file server or make server-based licenses available on the file server system which can then be used to license the client.

FATAL_ERROR: 

module-name:  module-name and explanation-string

Explanation:  An irrecoverable error has occurred that will cause the license server to terminate.  The message may return the name of the module in which the error occurred and an explanation of the possible cause.  

User Action:  Notify your Digital Equipment Corporation service representative or local authorized reseller.  Please save the log file so that it may be used to help diagnose the problem.

INIT_LOGFILE: 

Reason = explanation-string

Explanation:  A new version of the log file was created.  The reason string indicates whether it was done because the server started, or because of a License Manager request.

User Action:  None required.  

MESSAGE:  message-text

Explanation:  The message displayed describes diagnostic log event information.

User Action:  None required.  

�SERVER_STATE_CHANGE: 

Old State = previous-state-name �New State = new-state-name �Reason = explanation-string

Explanation:  The license server has been either enabled to serve the client requests or disabled.  The reason always indicates that it was at the request of the License Manager.  

User Action:  None required.

VIRTUAL_CLIENT_LICENSE_RETURNED_ON_ASSIGN:

Client Id = client-id number �Client Addr = client-address�Group = group-name�Product = product-name �Virtual Product = virtual-product

         Explanation:  The license requested by the client was a LAN Manager license, for example, PWLMDOSCC06.00.  The license software looks for a higher version of the product than requested either through license version lookup (described in Chapter 3, Configuring License Servers� \Relate "config.doc!4", "Configuring License Servers" \D2HTargetDefault �, in this guide) or license upgrade.  PATHWORKS Advanced Server license was assigned to that client, for example, PWLMXXXCA06.00.  Since the client will only accept a license name in the format of the license requested, the license server returns a “virtual license” to the client that conforms to the original format requested.  So the virtual license returned is in the form, "PWLMDOSCC07.00.  The client will accept it as simply a higher version of the PWLMDOSCC06.00 that it requested.  

User Action:  None required.

License Registrar Events

�xe "License Registrar:events "��xe "License Registrar:log "�This section describes the various events which can be logged to the License Registrar log file and the control logicals available to control the posting of events to the log file.

The types of events which the License Registrar posts to the License Registrar log file include:

INIT_LOGFILE

CLIENT_LICENSE_VALID

CLIENT_LICENSE_INVALID

CLIENT_ADDRESS_CHANGE

SERVER_LICENSE_ASSIGNED

SERVER_LICENSE_RELEASED

CLIENT_NOT_LICENSED

MESSAGE

FATAL_ERROR

By default, the License Registrar logs only the most significant events to prevent the log file from growing too rapidly.  If no control logicals are used to indicate that additional events should be logged, the default behavior is to post only the following types of events to the License Registrar log file:

INIT_LOGFILE

CLIENT_ADDRESS_CHANGE

MESSAGE

FATAL_ERROR

On occasion, it may be necessary to request the License Registrar to post more detail about requests being processed.  Should this become necessary, there are five control logicals that can be used to control the type of events posted to the License Registrar log file.

PWRK$LrLogVerbose 

Turning this control logical ON for the License Registrar causes messages for all event types to be posted to the License Registrar log file.

If the PWRK$LrLogVerbose control logical is not turned ON, the following logging control logicals may be used to enable specific types of additional logging:

PWRK$LR_Log_ClientBased_Activity 

Turning this control logical ON will enable the posting of messages related to the result of querying a client for a client-based license appropriate for accessing the file server (CLIENT_LICENSE_VALID and CLIENT_LICENSE_INVALID events). 

PWRK$LR_Log_ClientBased_Successes

Turning this control logical ON will enable the posting of messages when the License Registrar successfully validates a client-based license (CLIENT_LICENSE_VALID events). 

�PWRK$LR_Log_ClientBased_Failures

Turning this control logical ON will enable the posting of messages when the License Registrar does not receive a client-based license appropriate for accessing the file server after querying a client running client licensing software (CLIENT_LICENSE_INVALID events).  In this case the client may not have returned any license or none of the licenses returned by the client are valid for accessing the file server.

PWRK$LR_Log_ServerBased_Activity 

Turning this control logical ON will enable the posting of messages related to the assignment and release of server-based licenses by the License Registrar (SERVER_LICENSE_ASSIGNED, SERVER_LICENSE_RELEASED and CLIENT_NOT_LICENSED events).

Each control logical can be turned either ON or OFF.  Defining the logical to a value of one (1) turns the control logical ON; the control logical is considered OFF if it is undefined or defined to a value of zero (0).  If the logical is defined, the logical name must be defined in such a way as to make the definition available to the License Registrar process (by defining a system logical or defining the control logical in the License Registrar start-up command procedure SYS$StartUp:PWRK$License_R_Start.Com).  For example, to always log events related server-based licensing turn on the PWRK$LR_Log_ServerBased_Activity by defining a system logical:

$ DEFINE /SYSTEM  PWRK$LR_Log_ServerBased_Activity  1

CLIENT_ADDRESS_CHANGE: 

Old Client Addr = old-address-name �New Client Addr = new-address-name

Explanation:  The current network address of the client is different from the one it had when the license was granted.  This change may be valid, or it may indicate the illegal copying of license data from the old client to the new client.

User Action:  Make sure that the change of address is valid.  

�CLIENT_LICENSE_INVALID: 

Client ID = client-id number �Client Addr = client-address �Product = product-name �Group = group-name �Reason = explanation-string

Explanation:  The product license specified is no longer valid for the client.

User Action:  If the reason is an incorrect product, group, or license, the data on the client may no longer be valid (for example, the group may have been deleted).  Reconfigure the client to obtain a valid license.  If the license is in use by another client, this may be a case of illegal copying of license data between clients and should be investigated.  

CLIENT_LICENSE_VALID: 

Client ID = client-id number �Client Addr = client-address �Product = product-name �Group = group-name �Reason = explanation-string

Explanation:  The product license from the group specified is still valid.  The reason string indicates whether the client license was actually inspected or whether there was a cache entry match.

User Action:  None required.  

FATAL_ERROR: 

module-name:  module-name and explanation-string

Explanation:  An irrecoverable error has occurred that will cause the License Registrar to terminate.  

User Action:  Notify your Digital Equipment Corporation service representative or local authorized reseller.  

INIT_LOGFILE: 

Reason = explanation-string

Explanation:  A new version of the log file was created.  The reason string always indicates that it was done when the License Registrar started.

User Action:  None required.  

�MESSAGE: message-text

Explanation:  The message displayed describes diagnostic event information.

User Action:  None required.

SERVER_LICENSE_ASSIGNED: 

Product = product-name �Client Addr = client-address �Client ID = client-id number �Allocation = total-number -of-server-based-licenses-assigned

Explanation:  The client indicated did not have a client-based license sufficient to access the local file server and was assigned a server-based product license, granting the client the right to access the local file server.  The allocation indicates the number of server-based licenses in use after assigning the license.

User Action:  None required.  

SERVER_LICENSE_RELEASED: 

Product = product-name �Client Addr = client-address �Client ID = client-id number �Allocation = total-number -of-server-based-licenses-assigned

Explanation:  A client, previously assigned a server-based product license, has disconnected from the file server.  The server-based license previously assigned to this client has been released.  The allocation indicates the current number of server-based licenses in use after the release of the license.

User Action:  None required.  



�PATHWORKS Event Logger Errors

�xe "Server licensing messages"��xe "Licensing messages:server "��xe "License Manager:messages "��xe "Event Logger"�The PATHWORKS Event Logger logs events during PATHWORKS operation.  If a client is denied access to the PATHWORKS file server, an entry is posted to the PATHWORKS event log.  To check the PATHWORKS event log, enter the following command:

$ ADMIN/ANALYZE 

Look through the events displayed for access denied messages:

No server license for client — access denied.

Explanation:  The client is not licensed and no server licenses are available; therefore, the client is denied access.

User Action:  Obtain additional client-based or server-based licenses.  
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PATHWORKS Licensing Software Licensing Process

Introduction

This section describes the client licensing process.  This section includes the following topics:

PATHWORKS Licensing Software Algorithm� \Relate "licsw.doc!20", "PATHWORKS Licensing Software Algorithm" \D2HTargetDefault � – describes the specific steps in the client licensing process.

License Determination Algorithm� \Relate "licsw.doc!21", "License Determination Algorithm" \D2HTargetDefault � – describes the algorithm that the CLR uses to determine what license to request.

PATHWORKS Licensing Software Algorithm

�xe "Client-based license:description of"�� XE "PATHWORKS Licensing System:software algorithm" �� XE "Algorithm:for PATHWORKS licensing software" �The following table describes the specific steps in the client licensing process.  For more information, refer to Chapter 5, Configuring Client Software� \Relate "client.doc!3", "Configuring Client Software" \D2HTargetDefault � in this guide.

Table �styleref "BeginChapter"�C�–1   PATHWORKS Licensing Software Process

Step�What Happens��1.�When the client is booted, the CLT initializes the network (and, for Windows NT, writes an entry in the Application Event log), and then listens on the network for a license request. The CLR then looks for a license on the client.���If...�Then...���There a license is found on the client�The CLR attempts to verify the license by connecting to the license server that issued the license.���Result:����The license is verified. �Go to step 5.���The CLR could not connect to the license server.�The CLR assumes that the license on the client is valid.  Go to step 5.���The license is invalidated by the license server.�Go to step 2.���For each license that is not on the client, or is revoked by the server�Go to step 2.

In each case, the CLR writes logs a message.��2.�The CLR determines whether the user specified a license server name.  The CLR queries the local area network (LAN) for the PATHWORKS license server until one or more license server names are returned.  The CLR creates a list of license servers, starting with the license server specified by the user.

Note: For license acquisition over a wide area network (WAN), the client must be configured to specify the license server name.��3.�The CLR steps through the list of license servers, querying each license server to determine whether the license has been assigned to the user.  The client license data file is updated with the new information.���If...�Then...���The client has the requested license�Go to step 5a.���If the client is missing any requested license�Go to step 4.��4.�The CLR sends an assign request to the license server.���If...�Then...���A license is available

A license is not available�Go to step 5a.

The CLR prints a message to notify the user that it was unable to obtain a license.  (On Windows NT, an event is written to the Application Event log.)  Go to step 6.��5a.�The CLR loads the license into the CLT memory and updates the client license data file.  The user is notified of the license status. Go to step 6.��5b.�The CLR deletes the invalid licenses from the CLT memory and updates the license data file.  Go to step 6.��6.� Are there redundant or unnecessary licenses?���If...�Then...���Yes�The CLR clears the data file, releasing redundant or unnecessary licenses.  Go to step 7.���No�Go to step 7.��7.�Exit.��

License Determination Algorithm

� XE "PATHWORKS Licensing System:license determination algorithm" �� XE "Algorithm:for license determination" �The CLR uses the algorithm shown in the following table to determine what license to request�xe "Licensing algorithm:description of"�.

Table �styleref "BeginChapter"�C�–2   PATHWORKS Licensing Software License Determination Algorithm

Step�The Client License Requester...��1.�Looks for an existing license data file.

Is the license stored on the client?���If ...�Then ...���Yes�Verify the license.  Go to Step 5.��� No�Go to step 2.��2.�Looks for license information in the license configuration file.  (This step is configuration-dependent.  Refer to The License Configuration File for more information.)  Did the user specify a license configuration file at run time?���If ...�Then ...���Yes� Use the license information specified in the license configuration  file.  Go to step 5.��� No� Go to step 3.��3.�Looks for a PATHWORKS configuration template file (CFGxxxx.TPL) stored on the client.  (This step is configuration-dependent.  Refer to The PATHWORKS Configuration File for more information.)  Is there a specified license to request in the PATHWORKS configuration template file?���If ...�Then ...���Yes� Use the license information specified in the PATHWORKS configuration template file.  Go to step 5.���No�Go to step 4.��4.�Automatically looks for an appropriate license based on the client's configuration.  Is there an appropriate license based on the client's configuration?���If ...�Then ...���Yes�Use the appropriate license information.  Go to step 5.���No�A license is requested.  Go to step 5.��5.�End��
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Exiting, 4-4

F

File Name for Report dialog box, 4-27

FPA license
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FPS license, 2-8
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for client licenses, 4-27

for groups, 4-21

for products, 4-13

Getting help, 4-4

Groups

allocating licenses, 4-17

generating reports, 4-21
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setting the alert level, 4-20
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Help, 4-4
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Install
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Intruder detection lockout, A-2
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table of, 4-5
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template file parameters, 5-9
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moving licenses from one group to another, 4-19
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tasks, 4-15
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upgrading automatically, 2-12
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exiting, 4-4

list of menus, 4-2

list of menus, 4-5

messages, B-1, B-12

navigating screens, 4-5
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starting, 4-2

License product name definition, 5-7

License Registrar
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events, B-7
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License server

adding product licenses, 4-11

configuring, 4-4

creating a new version of the log file, 4-10

creating license groups, 4-15

creating state files, 3-3
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disabling and enabling, 4-7

enabling events for logging, 4-8

generating product reports, 4-13

license group tasks, 4-15

license product tasks, 4-11

listing licenses in a group, 4-16

listing product allocations, 4-12

log file tasks, 4-8

moving and changing the name, 3-5
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moving to a different system, 3-4

names, 3-2

selecting events for logging, 4-9

setting the alert level for product licenses, 4-13

sorting product displays, 4-13

state files, 3-1

synchronizing the database with LMF, 3-10

using, 4-7

License Server Startup Error Message screen, 4-4

License updates

post update tasks, 3-11

results of, 3-11

Licenses

adding product licenses, 4-11

allocating to a group, 4-17

component program log files, B-2

moving to another group, 4-19

process-related log files, B-1

removing all licenses for a product, 4-12

revoking a client's license, 4-23

version lookup, 3-6

Licensing algorithm

description of, C-3

Licensing messages

client, A-1

server, B-1, B-12

Licensing software

parameters for Windows for Workgroups, 5-11

parameters on Windows 95, 5-12

parameters on Windows for Workgroups, 5-10

parameters on Windows NT, 5-12

properties on Windows 95 network control panel, 5-13

Listing

licenses in a group, 4-16

product allocations, 4-12

Loading Client Access licenses, 2-12

Log events

enabling and disabling, 4-8

Log File Options screen, 4-9

Log files

component program log files, B-2

creating a new version, 4-10

location, 4-8

process-related log files, B-1

selecting events for logging, 4-9

M

Main menu screen, 4-2

with theView menu displayed, 4-3

Messages, A-1, B-1

client, A-1

server, B-1

Modify License Product Allocation screen, 4-17

Moving

license server and changing the name, 3-5

license server and retaining server name, 3-4

license server to a difference system, 3-4

N

Navigating the License Manager, 4-5

NETMBX privilege, 4-2

New Group or Product screen, 4-15

O

Obtaining client-based licenses over WANs, 5-14

OpenVMS clusters, 1-4
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for client-based license management, 1-8

for server-based license management, 1-7

Options for upgrading client licenses, 2-9
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template file parameters for Windows for Workgroups,   5-12

PATHWORKS license management, 2-4

examples of, 2-4, 2-6, 2-8

models description of, 1-6

PATHWORKS Licensing System

components, 1-1, 1-3

description of, 1-1

diagram, 1-2

license determination algorithm, C-3

software algorithm, C-1

Planning

client-based license management, 2-2

combined license management, 2-3

server-based license management, 2-2
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listing, 4-12
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sorting, 4-13

Product licenses

adding to the license manager, 4-11

removing, 4-12

See also Licenses, 4-11

tasks related to, 4-11
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generating, 4-13

PWLICLM.EXE program

command syntax, 5-5

PWLICLM.EXE program See also Client license requester program, 5-5

R
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product licenses, 4-12
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for client licenses, 4-27

for groups, 4-21

for products, 4-13

Revoking client licenses, 4-23
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Server Enable/Disable screen, 4-7
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Server Options screen, 4-7

Server-based license

about, 1-7

management model, 1-7
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management, operations, 1-7

management, planning, 2-2

management, setting up, 2-2

management, when to use, 1-7

Setting the alert level

for groups, 4-20

for product licenses, 4-13

Setting up

client-based license management, 2-2

combined license management, 2-3

server-based license management, 2-2

Showing client details, 4-25

Sort Options

for Groups screen, 4-21

for Licenses screen, 4-26

for Products screen, 4-14

Sorting

client license lists, 4-26

group displays, 4-21

product displays, 4-13

Specifying when license servers run in a cluster, 3-10

Starting

the client license requester, 5-3

the client license transponder, 5-3

State file, 3-1

Synchronizing the license server database with LMF, 3-10
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Upgrading from PATHWORKS V5, 1-6
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automatic license upgrades, 2-12
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